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Foreword

The EBV-IoT — Infineon loTConnect Secure Cloud connected
solution is a powerful and innovative system that brings together the
latest advancements in 10T technology and cloud connectivity to
provide a highly secure and reliable platform for businesses looking
to embrace the benefits of the Internet of Things. This solution
offers a range of features and capabilities that make it ideal for a
wide range of applications, from smart homes and buildings to
industrial automation and beyond. With its advanced security
features, real-time data analytics, and flexible deployment options,
the EBV-10T — Infineon loTConnect Secure Cloud connected
solution is poised to become one of the leading solutions in the fast-growing 10T market.
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Figure 1: The solution high level overview block diagram

The solution was developed using internal expertise from EBV Elektronik and is built on a foundation of
advanced hardware and software components, including Infineon PSoC™ MCU, AIROC™ CYW43012
based muRata Type 1LV WiFi/BT combo module, PAS CO2 and DPS310 pressure sensors using EBV
internally developed PAS CO2 and OPTIGA Trust M evaluation shields, as well as the Avnet loTConnect
cloud platform.

The PAS CO2 evaluation shield is designed for seamless evaluation using standard hardware interface
and to provide accurate and reliable CO2 monitoring for a wide range of applications, from indoor air
quality monitoring to industrial automation. Similarly, the OPTIGA Trust M evaluation shield simplifies
access to advanced security features that are critical for ensuring the integrity and confidentiality of data
transmitted over the 10T network.

Finally, the Avnet loTConnect cloud platform provides a highly scalable and flexible cloud infrastructure
that enables the secure and efficient management of 10T devices and data. With its advanced analytics
and visualization tools, as well as its powerful security features, the Avnet loTConnect cloud platform is
the perfect complement to the above hardware system.

Overall, the EBV-I0T — Infineon loTConnect Secure Cloud connected solution represents a major leap
forward in the world of 10T, providing businesses with a powerful and flexible platform for leveraging the
full potential of this exciting technology.
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1. Introduction

EBV Elektronik has designed a complete onboarding flow on top of Avnet loTConnect cloud to simplify
loT device onboarding and cloud platform evaluation. From building a complete cloud environment in an
instant, leveraging the challenge of building state of the art secured 10T device (using EBV Elektronik
hardware and software), to bringing data to end user via the EBV Mobile App. This cloud ecosystem
aims at offering a fast, innovative, and scalable platform which provides real product differentiation to
customers at minimal cost.

/IOTCONNECT® Gafineon
aWS A Azure @ O
™
Q @ = @ OPTIGA Trustl@

Create your Program HW
loTConnect Secure Element (linfineon
Account

Create and register

your Device
¥

E3E

e VR o 2 o

- [\ CYW43012 ..
muRlata Type 1LV
Visualize device data Run EBV Mobile App Program the EBV
& remote control & Scan QR Code loTConnect Software Stack

The goal of this training is to connect the demo setup to the Avnet loTConnect cloud using one of the
best-in-class hardware security thanks to Infineon OPTIGA™ Trust M secure element. As main platform
we will be using Infineon PSoC 62 MCU and CYW43012 based Wi-Fi/BT combo connectivity module. A
set of Infineon Xensiv™ sensors will complete the device hardware setup to provide a more advanced
product.

This training manual will guide you through a hands-on session following every step on the device
secure cloud connection path. The training demonstrates how to build, develop and deploy an
affordable, state of the art, end-to-end secured solution.
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The following topics will be covered:

¢ Infineon PSoC 62 Programming & JTAG Debugging.

¢ Infineon OPTIGA Trust M provisioning for loTConnect Cloud.
e Connecting the demo setup to lIoTConnect Cloud.

¢ Remote Control from the EBV Mobile App.

e Creating custom dashboard

Quick start: There is a “Quick Start” path available marked using fast forward icon. Follow the
}}I icon to skip the parts related to device programming and debugging using ModusToolbox™.

1.1. Deliverables

The training material is provided during the Training sessions and comes as:

e EBV-I0TC Training Zip (.zip file)
e EBV-I0TC Training no MTB Zip (.zip file without ModusToolbox)

The different resources needed to complete this training (hands-on documentation, datasheets,
application notes, software & tools) are included in the delivery. However, the training manual always
refer you to latest documentation provided by the manufacturers on their respective websites.

The training Zip is composed of following main folders:

e EBV Documentation: documentation and related information for EBV-I0T products
e Firmware: PSoC executable for loTConnect demo
e Infineon documentation: documentation and related information for Infineon products
e MobileApp: source code for EBV-I0T Mobile Application
e MTB Project: ModusToolbox project used to build the loTConnect Secured Solution
e Scripts: Python scripts for Optiga management
e Sources: source files for ModusToolbox projects to be used with the training
e Template: loTConnect device template to upload to the cloud.
e Tools: installation files for the tools to be used during this training.
In the ‘root’ folder there are this training manual and training overview.

1.2. Icon key identifiers

Icons are used to notify about valuable information or point out important steps to follow. These icons
are:

|:—% Note: Provides valuable information about a specific topic

\'I

‘,Q‘ Tip: Indicates useful tips and techniques

To Do: Highlights objectives to be completed and possible extensions
g—

—1 Task accomplished: Highlights the expected results of the specific task

lIrl Important: Indicates important information

}}I Quick start: Showing the path for Quick Start version of the manual
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https://www.avnet.com/wps/portal/ebv/

I An Avnet Company |

1.3. Document conventions

Table 1: Document Conventions for the manual

Convention Usage

Italic-Bold In document or externally referenced link

Bold Clickable menu item

IBold Squared | Clickable web page or menu item to be clicked during the tasks
Consolas Commands to be executed or messages displayed in terminal

1.4. Basic requirements

Following will be required during the training:

1. A computer with Windows 10 or above, or Linux
2. Android or Apple device to install mobile app (it also enables to seamlessly follow the training using
online manual)
3. Hardware requirements:
a. The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-062S2-43012)
b. EBV-IoT — Infineon PAS CO2 Evaluation Shield
c. EBV-IoT - Infineon OPTIGA Trust M Evaluation Shield
d. 128x128 pixels OLED display (optional)
4. Software requirements:
a. ModusToolBox 3.1 or above
b. Python (modus-shell may be used) with installed libraries
5. Avnet loTConnect cloud platform account

A

1.5. Notes

Note: There is a 2 Prerequisites section with detailed requirements available.

Please follow the steps carefully!

Note: Some of the steps marked A, B, C... have same outcome, just different way to get
— there.

There is online version of the training manual available you can access during the hands-on using your
mobile phone or tablet. It improves pace as you do not have to switch between applications. Use
following QR code to access the online manual.

A

Not all the steps are required to follow in full. Based of your preferences, you can skip some steps and
follow the tips to overtake some parts and allows you to focus more on a topic of your choice.

Note: Only hands-on relevant sections are available online.

.~ Tip: Tips are providing you information on steps you can eventually skip and focus more on
O- topics of your choice.
\

/
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1.6. Links

Following please find additional links you may find useful or is being used as extra reading material:

1. ModusToolBox landing page
MylInfineon landing page
PSoC™ landing page
Xensivlanding page
OPTIGA™ Trust M landing page

arwbd
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2. Prerequisites

Following please find hardware and software prerequisites.

2.1. Hardware prerequisites

Important: To run the complete workshop hands on part a computer with admin/root rights
should be used. Windows OS is preferred, while for Linux should be able to run as well.

I
—\r
Following evaluation hardware is going to be used during the training:
e The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-062S52-43012)

e EBV-IoT —Infineon PAS CO2 Evaluation Shield
e EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield

e 128x128 pixels OLED display (optional)

« {wt I 4

The PSoC™ 62S2 Wi-Fi BT Pioneer Kit
(CY8CKIT-06252-43012)

=

EBV-loT — Infineon OPTIGA Trust M Evaluation Shield
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2.2. Software prerequisites

2.2.1 Installing ModusToolbox™
Quick start: For the “Quick Start” version of the Infineon loTConnect Cloud connected
}}I solution ModusToolbox™ is not required and you can skip to Sub-section 2.2.2 Installing
ModusToolbox™ Programmer. However, if you would like to get familiar with Infineon
ModusToolbox™, we still recommend installing it for your reference.

Please refer to the Infineon’s ModusToolbox™ Software pages for application download and
“Installation guide” (link).

Note: It is strongly recommended to install the tool into the root of any of your disk drives e.g.
— “D:/Infineon”. Please do keep the name as short as possible and do not use spaces or any

special characters.
Default location of installation directory for the Eclipse IDE is:
<install_path>\ModusToolbox\ide_<version>\eclipse\

Important: If the software is installed in any other than default location you have to set an
! I environment variable. Please follow the ModusToolbox installation guide or follow next
steps.

To check for ModusToolBox environmental variable setting, under Windows [Start menu or Windows|
type in “env”... . The [Edit the system variables| should soon be listed on top as shown on
Figure bellow.

All Apps Documents Settings More ¥

Best match

y Edit the system environment p:
= variables
D

Control panel

Edit the system environment variables

Control panel

Settings

= Edit environment variables for your
account

[ Change brightness automatically
when lighting changes

Documents - This PC (7+)

Apps (1)

O env
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Now click on [Environmental Variables| and look for “System Variable” CY_TOOLS_PATHS.

System Properties X Environment Variables X

Computer Name Hardware CEd System Protection Remote
User variables for MaliU

You must be logged on as an Administrator to make most of these changes

Performance Variable Value ~
Visual effects, processor scheduling. memory usage, and virtual memory IDF_TOOLS_PATH D:\Espressif
IFX_TOOLBOX_UUID 6d447e14-046-3b4c-9c52-35cdbbda9ab8
Setiings. OneDrive CA\Users\maliu\OneDrive - Avnet
OneDriveCommercial CA\Users\maliu\OneDrive - Avnet
User Profiles Path D:A\Renesas\LLVM for Renesas RL78 10.0.0.202306\bin;D:\Rene...
Desktop settings related to your sign-in SAPLOGON_LSXML_FILE CA\ProgramData\SAP\SAPUILandscape.xml
TEMP CA\Users\maliv\AppData\Local\Temp v
Setings —aan D
Startup and Recovery New... Edit.. Delete
System startup. system failure. and debugging information
System variables
Setings.
~

Variable Value

PN BNy Dy
D:/Infineon/ModusToolbox/tools_3.1

P

Environment Variables CY_TOOLS_PATHS

ohveroEE wmae

IWBPath C\Program Files (x86)\SAP\FrontEnd\iwb
Cancel 2l NUMBER_OF_PROCESSORS 16
0Ss Windows_NT
Path DAPython\Python311\Scripts\;D:\Python\Python311y,C\Progr...

mw... Edit... b!ete

Please proceed accordingly:

A. If the variable does not exist, then in “Environment Variables” window click , then in new pop-up
window “New System Variable” at “Variable name” type CY_TOOLS_PATHS and in “Variable value” put
your ModusToolBox path or browse using Browse Directoryl. Then click as well as click in
“Environment Variables” window.

New System Variable X
Variable name: | CY _TOOLS_PATHS |
Variable value: | DAlnfineon\ModusToolbox\tools_3.1 |

Browse Directory... Browse File... Cancel

B. If the variable exist, then in “Environment Variables” window click , then in new pop-up window
“Edit System Variable” check if “Variable name” matches to CY_TOOLS_PATHS and “Variable value”
matches to your ModusToolBox path or browse using Browse Directory]. Then Click as well as
click in “Environment Variables” window.

Edit System Variable X
Variable name: | CY_TOOLS_PATHS| |
Variable value: | D:/Infineon/ModusToolbox/tools_3.1 |

Browse Directory... Browse File... Cancel

3 Important: Very important — use forward slashes. / - ok; \ - not ok
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After successful installation you should be able to see the tools installed in your start menu under
“ModusToolbox 3.1 (Current user)”.

- ModusToolbox 3.1 (Current user)
bsp-assistant 1.10.0
bt-configurator 2.80.0

capsense-configurator 6.10.0
New

capsense-tuner 6.10.0

dashboard 3.1.0

device-configurator 4.10.0

Eclipse g)E for ModusToolbox 3.1

ez-pd-configurator 1.21.0

fw-loader 3.5.0

library-manager 2.10.0

lin-configurator 1.21.0

BN modus-shell 1.40

l ModusToolbox 3.1 Documentation

Figure 2: Start menu with ModusToolbox installed

If clicked on [Eclipse IDE for ModusToolBox 3.1 you will see a “Launcher” window popping out.

E Eclipse IDE for ModusToolbox™ Launcher X

Select a directory as workspace

Eclipse IDE for ModusToolbox™ uses the workspace directory to store its preferences and development artifacts.

Workspace: | C/EBV-loTC v Browse...

[[] Use this as the default and do not ask again

Task accomplished: If you can run “Eclipse IDE for ModusToolbox™ Launcher” and a

v= workspace selection window is opening, you are good to proceed to a next step.

2.2.2 Installing ModusToolbox™ Programmer
Note: For the “Full” version of the Infineon loTConnect Cloud connected solution
= ModusToolbox™ Programmer is not required and you can skip to Sub-section 2.2.3 Running
Python (“modus-shell”)

Please refer to the Infineon’s ModusToolbox ™ Programmer Software pages for application download
and “ModusToolbox™ Programming GUI user guide” (link) for installing instructions.
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After successful installation you should be able to see the tools installed in your Windows
under:

A. Recently added->mtb-programmer x.x, or
B. [Infineon technologies|->mtb-programmer x.x

where x.x denotes version of the installed tool.

- Infineon

- Infineon Developer Center

= Recently added

. mtb-programmer 5.0

#

i Infineon Technologies

CYP User Guide

@ Cypress Programmer 4.1

mtb-programmer 5.0
New k
Release Notes

i Infineon Toolbox

mtb-programmer - O X

Probe/Kit: None ~ | Platform: None = =

Open Power Connect Erase Program Read Verify

Settings x

Program Settings

File (]
Reset Chip

Probe Settings

Log

Info : [CyBridge] Start the API initialization

Info : [CyBridge] The hardware initialization has completed in 794 ms

Info : Connected - KitProg3 CMSIS-DAP BULK-1E@F177E@1051400 FW Version 2.48.1241
Recommended to upgrade Firmware of 'KitProg3 CMSIS-DAP BULK-1E@F177E@1051400°

Info : Selected Device: CYBCKIT-@6252-43012-1E@F177E@105140@

Info : Selected Device: None

PressFlforhelp e Not Connected

Figure 3: ModusToolbox™ Programmer

Task accomplished: If you can run “mtb-programmer” as depicted in Figure 3:
— ModusToolbox™ Programmer you are good to proceed to a next step.

2.2.3 Running Python (“modus-shell”)
Python is required for OPTIGA™ Trust M provisioning.

-, Note: If you have Python already installed you can proceed to a step 2.2.4 Installing
:/{ “optigatrust” Python module.
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If you do not have Python nor ModusToolbox™ (as one of the prerequisites of the “Full” version of the
workshop) installed, you can either:

A. Install Python from the “python.org” pages (link), or
B. Install ModusToolbox™ (as in Sub-section 2.2.1 Installing ModusToolbox) which comes with “modus-
shell” Python instance as part of the installation

Having ModusToolbox™ installed, the easiest way of running “modus-shell” is to look for it under
Windows search by typing in “modus”... . The application should soon be listed on top as shown on
Figure 4. Click on the “App” to run the application.

All Apps Documents Settings

Best match

- modus-shell 1.4.0
App

Apps

modus-shell 1.4.0
Eclipse IDE for ModusToolbox 3.1 App

B  Module Docs

B ModusToolbox 3.1 Documentation 7 Open

W Open file location

B Python 3.9 Module Docs (64-bit)

B Python 3.11 Module Docs (64-bit) A Uyl
Documents - This PC (14+)

Photos (1+)

O moduk-shell 1.4.0

Figure 4: Starting "modus-shell”

Now run either your instance of Python or “modus-shell” Python instance. Please check whether
“optigatrust” Python module is installed. Type “optigatrust.exe” into the terminal. If your replay is
“bash: optigatrust.exe: command not found”, please proceed to Sub-section 2.2.3 Error! Not a
valid bookmark self-reference. otherwise proceed to Sub-section 2.2.5 Installing other Python
modules.

user@computer_name ~
$ optigatrust.exe
bash: optigatrust.exe: command not found

user@computer_name ~

$

2.2.4 |Installing “optigatrust” Python module
Please install the “optigatrust” Python module by executing “pip install optigatrust”. Installation is
successful if “Successfully installed...” message appears.
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user@computer_name
$ pip install optigatrust
Collecting optigatrust
Downloading optigatrust-1.3.7-py3-none-any.whl (493 kB)
| 493 kB 2.2 MB/s
Requirement already satisfied: cryptography in d:\infineon\modustoolbox\tools_3.1\python\lib\site-
packages (from optigatrust) (36.0.1)
Requirement already satisfied: click in d:\infineon\modustoolbox\tools_3.1\python\lib\site-packages
(from optigatrust) (8.0.4)
Collecting jinja2
Downloading Jinja2-3.1.2-py3-none-any.whl (133 kB)
| IR | 1:: kB 6.8 MB/s
Collecting pyserial
Using cached pyserial-3.5-py2.py3-none-any.whl (90 kB)
Collecting asnlcrypto
Downloading asnlcrypto-1.5.1-py2.py3-none-any.whl (105 kB)
| IR | o5 kB 6.4 MB/s
Requirement already satisfied: colorama in d:\infineon\modustoolbox\tools_3.1\python\lib\site-
packages (from click->optigatrust) (0.4.5)
Requirement already satisfied: cffi>=1.12 in d:\infineon\modustoolbox\tools_3.1\python\lib\site-
packages (from cryptography->optigatrust) (1.15.1)
Requirement already satisfied: pycparser in d:\infineon\modustoolbox\tools_3.1\python\lib\site-
packages (from cffi>=1.12->cryptography->optigatrust) (2.21)
Collecting MarkupSafe>=2.0
Downloading MarkupSafe-2.1.2-cp38-cp38-win_amd64.whl (16 kB)
Installing collected packages: MarkupSafe, pyserial, jinja2, asnlcrypto, optigatrust
Successfully installed MarkupSafe-2.1.2 asnlcrypto-1.5.1 jinja2-3.1.2 optigatrust-1.3.7 pyserial-3.5

user@computer_name

Quick check for proper “optigatrust” Python module installation is to run “optigatrust” or
“‘optigatrust.exe” command. We should see a replay with short usage instructions.

user@computer_name
$ optigatrust.exe
Usage: optigatrust [OPTIONS] COMMAND [ARGS]...

Options:
--version Show the version and exit.
--help Show this message and exit.
Commands:
create-keys Generate a keypair
object Manages objects data and metadata
update Use protected update feature

update-wizard Guide through the protected update preparation for a...

user@computer_name

$

2.2.5 Installing other Python modules
To run all the steps related to secure element interfacing using Python scripts, we need to add
OpenSSL, QRcode and image related modules. Please install the modules using following commands:

e “pip install pyopenssl’
e “pip install pillow”
e “pip install grcode”
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user@computer_name ~

$ pip list

Package Version
appdirs 1.4.4
openssl-python 0.1.1
optigatrust 1.3.7
Pillow 9.5.0
pyOpenSSL 23.1.1
grcode 7.4.2

WARNING: You are using pip version 21.1.3; however, version 23.1.2 is available.
You should consider upgrading via the 'D:\Infineon\ModusToolbox\tools_3.1\python\python.exe -m pip
install --upgrade pip' command.

user@computer_name ~

$

Task accomplished: If your “pip 1ist” is listing “optigatrust”, “pyopenssl”, “pillow”, and
“grcode” you are fulfilling Python related requirements.

2.3. Create loTConnect cloud account

As a first step in every cloud platform it is to create your cloud access account. Use your favourite
browser to access EBV loTConnect website at https://iotconnect.io/ebv and click |Request a Free]
loTConnect Account;

3] EBVElektronik /IOTCONNECT

EBV loT -
loTConnect Cloud Platform

REQUEST A FREE IOTCONNECT ADMIN ACCOUNT

An end-to-end loT journey for your loT applications

loTConnect is a full-fledged platform as a Service (Paas). This horizontal loT platform aliows for device communication and management, data storage,
app creation as well as enablement and robust security protocols
&

loTConnect is the only 0T platform available in the market that comes with a powerful device management system and built-in analytics that allows you to
connect and manage devices with little to no coding. Its powerful yet easy-to-use interface enables enterprises to create applications faster than laborious

Complexity
coding saving a lot of time and money.
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Enter your details and make sure your email address is valid then click button:

Request a Free loTConnect Admin Account
FIRST NAME * LAST NAME *
EMAIL * PASSWORD *
COMPANY NAME = COUNTRY CODE * PHONE *
ADDRESS * COUNTRY *
Select Country v

STATE* TIMEZONE *

Select State ~ (UTC+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna v

_ _ B

CITY NAME * POSTAL CODE *

SUBMIT

3 Important: Password must contain at least 1 upper case and special character.

If the provided information is correct, a confirmation popup invites you to check your emails for an email with a link
to validate your email address. Press button: Usually, the browser returns you to the beginning of the

page.

iotconnect.io says

Your details have been saved successfully. Please check your inbox to

verify your email address and complete registration process.

Please check your mailbox. You should be receiving email with a content like one bellow. Click on

[Email Now/

Hello Uros Mali,
Welcome to loTConnect!

Please click below link to verify your email address and complete the registration
process for your free loTConnect account.

Verify Email Now

Best Regards,
The loTConnect team

ssc@ebv.com

Copyright ©2021 Avnet, Inc. All rights reserved.
Knowledgebase - FAQ - Human Rights - Privacy - Terms of Use
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The webpage loads again and process the creation of your account in the background. Once complete,
below popup should open to confirm your loTConnect account has been created successfully. Click
button:

iotconnect.io says

Company registered successfully.

Please check your mailbox. You should now get confirmation email with a link to the cloud platform.

Hello Uros Mali,

Your free loTConnect account is ready. Please use below credentials to connect to
your account:

URL : https://avnet.iotconnect.io
Username : email@domain.com

Best Regards,
The loTConnect team

ssc@ebv.com

Copyright ©2021 Avnet, Inc. All rights reserved.
Knowledgebase - FAQ - Human Rights - Privacy - Terms of Use

Login to the cloud using email and password you provided during registration process.

Avnet / I0TConnect x  +

C (O & loginiotconnectio,

/\VNE T/107coNNECT

Welcome back,

Please login to your account

? ol
“l[lu III _‘- n!!
e L]

If it happens you forgot your password, you can reset the password by clicking |Forgot Password?| at
login page.
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Reset your password by providing new one and confirmation of the same password and click [Submit|.

3 Important: Password must contain at least 1 upper case and special character.

Avnet / I0TConnect X +

C © @ loginiotconnectio

e
AVNE T/ 07CONNECT

Welcome back,

Reset your password

8 ®
8 @

Powered by Softweb Solutions Inc. (An Avnet Company)
Copyright ©2023 Avnet, Inc. All rights reserved loTConnect Terms of Use

You should be now seeing “Welcome back” page.

Avnet / I0TConnect x +

C (O & loginiotconnectio

6
AVNE T/ 07cONNECT

Password changed successfully.

i/"\/ Welcome back,
’ S/ Please login to your account
l'l
2l
m
ol
Next
b
Powered by Softweb Solutions Inc. (An Avnet Company).
Copyright ©2023 Avnet, Inc. All righis reserved loTConnect Terms of Use
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After a successful login, the loTConnect backend will land to the Dashboard page showing information
related to device activities (device to cloud messages, command, twin properties, rule, natification,
events, etc) and the current subscription plan:

_ IOTConnect X +

C ( @& avnetiotconnectio,

= L\V N E T 8 107 Dasnbcard #8 Dashboards @) Create Dashioard o 2 ‘ v

& loT Dashboard e
D2c o Command 5 Twin n Subscription

Plan renews on
Plan

EBV - loTConnect O5521/2|023
User Device Message
1/50 0/50 0/4.5m (0%)
Device Counter
Total Acquired
Rule Notification Events
] D )

Disconnected Available

Task accomplished: Congratulations, you have just created your free Avnet loTConnect
Y=| cloud account. Save your loTConnect login credentials securely for your next use.
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3. Main system components

3.1. PSoC62

The PSoC® MCU is a scalable and PSoC 62 Line

reconfigurable platform architecture that MCU Subsystem | Analog Blocks [/ Subsystem
supports a family of programmable embedded | | |
system controllers with Arm® Cortex® CPUs > I |
(single and multi-core). The PSoC 62 product | |

family, based on the PSoC 6 MCU platform, is a
combination of a dual-core microcontroller with mn_aB,ocks

built-in programmable peripherals. It | |
incorporates integrated low-power flash | |
- . . [Communication Interfaces
technology, digital programmable logic, high- |:| | |
performance analog-to-digital and digital-to- I:I
analog conversion, low-power comparators, I:I ' |

touch sensing, serial memory interface with
encryption, and standard communication and | oo | | |

timing peripherals. | owa | | 5 | |
| cruse |
| rc |

H

3.1.1 Main features
32-bit Dual CPU Subsystem

¢ 150-MHz Arm® Cortex®-M4F (CM4) CPU with single-cycle multiply, floating point, and memory
protection unit (MPU)

¢ 100-MHz Cortex-M0+ (CMO0+) CPU with single-cycle multiply and MPU

e User-selectable core logic operation at either 1.1V or 0.9 V

e Active CPU current slope with 1.1-V core operation

e Active CPU current slope with 0.9-V core operation

e Two DMA controllers with 16 channels each

Memory Subsystem

e 1-MB application flash, 32-KB auxiliary flash (AUXflash), and 32-KB supervisory flash (Sflash); read-
while-write (RWW) support. Two 8-KB flash caches, one for each CPU

o 288-KB SRAM with power and data retention control

e One-time-programmable (OTP) 1-Kb eFuse array

Low-Power 1.7-V to 3.6-V Operation

e Six power modes for fine-grained power management

o Deep Sleep mode with SRAM retention

e  On-chip Single-In Multiple Out (SIMO) DC-DC Buck converter
e Backup domain and real-time clock

Flexible Clocking Options

e On-chip crystal oscillators

e Phase-locked loop (PLL) for multiplying clock frequency

¢ Internal main oscillator (IMO)

e Ultra-low-power internal low-speed oscillator (ILO)

e Frequency locked loop (FLL) for multiplying IMO frequency
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Quad-SPI (QSPI)/Serial Memory Interface (SMIF)

e Execute-In-Place (XIP) from external Quad SPI Flash

e On-the-fly encryption and decryption

e 4-KB cache for greater XIP performance with lower power
e Supports single, dual, quad, dual-quad, and octal interfaces

Serial Communication

¢ Nine run-time configurable serial communication blocks (SCBs)
o Eight SCBs: configurable as SPI, I12C, or UARTs
o One Deep Sleep SCB: configurable as SPI or 12C

e USB full-speed device interface

Audio Subsystem
e Two PDM channels and one 12S channel with TDM mode
Timing and Pulse-Width Modulation

e Thirty-two timer/counter pulse-width modulators (TCPWMs)
e Center-aligned, Edge, and Pseudo-random modes
e Comparator-based triggering of Kill signals

Programmable Analog

e 12-bit 1-Msps SAR ADC with differential and single-ended modes and 16-channel sequencer with
result averaging

¢ One 12-bit voltage mode DAC

¢ Two low-power comparators available in Deep Sleep and Hibernate modes

e Two opamps with low-operation modes

¢ Built-in temp sensor connected to ADC

Up to 100 Programmable GPIOs

e Two Smart I/O ports (16 1/0s) enable Boolean operations on GPIO pins; available during system
Deep Sleep

e Programmable drive modes, strengths, and slew rates

¢ Six overvoltage-tolerant (OVT) pins

e LCD segment direct block support up to 61 segments and up to 8 commons
e Operates in Active, Sleep, and Deep Sleep modes

Capacitive Sensing

e CapSense Sigma-Delta (CSD) provides best-in-class SNR, liquid tolerance, and proximity sensing
¢ Enables dynamic usage of both self and mutual sensing
e Automatic hardware tuning (SmartSense™)

Security Built into Platform Architecture

¢ ROM-based root of trust via uninterruptible Secure Boot
e Step-wise authentication of execution images
e Secure execution of code in execute-only mode for protected routines
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Main system components

Manual (TRM)” document for all the details related to PSoC 62 series of MCUs (link).

I—j‘} Note: Please refer to “PSoC 6 MCU: CY8C62x6, CY8C62x7 Architecture Technical Reference

3.2. AIROC™ CYW43012 WiFi/BT combo

The Cypress CYW43012 single-chip device integrates a IEEE 802.11a/b/g/n compliant 802.11ac-
friendly MAC/baseband/radio and Bluetooth 5.0 + EDR (enhanced data rate). It provides a small form-
factor solution with minimal external components to drive down cost for mass volumes and allows for
handheld device flexibility in size, form, and function. Comprehensive power management circuitry and
software ensure the system can meet the needs of highly mobile devices that require minimal power

consumption and reliable operation.

WLAN Subsystem

A

Advanced On-Chip
BT/WLAN
Coexistence

Coexistence
Interfaces

Bluetooth Subsystem

IEEE 802.11x Key Features

o Full IEEE 802.11a/b/g/n compatibility with
enhanced performance.

e 802.11ac friendly, MCS8 (256-QAM) for 20
MHz channels in 5 GHz band.

e Single spatial stream with PHY data rates of
up to 72.2 Mbps with 802.11n (MCS7) and
78 Mbps with 802.11ac (MCS8).

e 20 MHz channels with optional SGI support
for MCSO-MCS?7.

e |EEE 802.11ac explicit beamformer support.

e TXand RX low-density parity check (LDPC)
support for improved range and power
efficiency.

¢ Receive space-time block coding (STBC)

e On-chip power amplifier/low-noise amplifier
for both bands.

MCS8 in 20 MHz channels (5 GHz band)
proven to be interoperable with 802.11ac
access points.

Support for front-end modules (FEMS).
Supports RF front-end architecture with a
single dual-band antenna shared between
Bluetooth and WLAN.

Shared Bluetooth and WLAN receive signal
path.

Supports standard SDIO v2.0 and SDIO
v3.0 (SDR40 at 80 MHz and DDR40 at 40
MHZz).

Backward compatible with SDIO v2.0 host
interfaces.

Integrated ARM processor with on-chip
RAM and ROM minimizes the need to
wake-up the applications processor for

. standard WLAN functions.
¢ Embedded IPV6 network stack for use with
WICED SDK.
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Bluetooth Key Features

5

3.3.

The XENSIV™ PAS CO2 sensor is a real carbon dioxide (CO2) sensor in an
unprecedented small form factor. Designed on the basis of the photoacoustic
spectroscopy (PAS) concept, the sensor saves more than 75 percent space
compared to existing commercial real CO2 sensors. Its direct ppm readings, tape
& reel packing, SMD capability and simple design allow for a quicker and easier
integration into customers’ systems in low and high-volume applications alike.

EBV-IoT — Infineon loTConnect Secure Cloud connected solution - Training Manual ver 1.4

Complies with Bluetooth Core Specification
Version 5.0 with
provisions for supporting future
specifications.

o QDID: 104548

o Declaration ID: D035924
Bluetooth 5.0 compliant with 2 Mbps GFSK
data rate for BLE.
All optional Bluetooth 4.2 features
supported.
Bluetooth Class 1 or Class 2 transmitter
operation.
Supports BDR (1Mbps), EDR (2/3Mbps),
BLE (1/2Mbps).
Host controller interface (HCI) using a high-
speed UART interface.
PCM for audio data.
Ultra low TX o/p power mode to enable use
cases like proximity pairing etc.
Embedded Bluetooth host stack in ROM.
Low power consumption improves battery
life of handheld devices.
Supports extended synchronous
connections (eSCOQ), for enhanced voice
quality by allowing for retransmission of
dropped packets.
Supports multiple simultaneous Advanced
Audio Distribution Profiles (A2DP) for stereo
sound.
Adaptive frequency hopping (AFH) for
reducing radio frequency interference.

Main system components

General Features

Supports battery voltage range from 3.2V to
4.6V supplies with internal switching
regulator.

Programmable dynamic power
management.

6144 bits of OTP for storing board
parameters.

40 GPIOs:

o 16 WLAN

o 4 Bluetooth (more available if
12S/PCM/JTAG are not used)

o 20 shared

Security:

o WPA, WPA2 (Personal) with security
improvements, WPA3 (Personal)
support for powerful encryption and
authentication

o AES and TKIP in hardware for faster
data encryption and IEEE 802.11i
compatibility

Worldwide regulatory support: Global
products supported with worldwide
homologated design.

Packages:

o 251-pin WLCSP package (3.76 mm
x 4.43 mm, 0.2 mm pitch)

o 300-ball FCBGA package (9mm x
9mm, 0.4mm pitch)

o 106-ball WLBGA package (3.76mm
X 4.43mm, 0.35mm pitch)

Note: Please refer to “CYW43012” product pages for all the details related to CYW43012

j wireless combo (link).

XENSIV™ PAS CO2 sensor
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Key features Key applications
¢ Small form factor (14 x 13.8 x 7.5 mm3) ¢ HVAC (heating, ventilation and air
e High accuracy (+30 ppm +3% of reading) conditioning) systems
and robust performance e Smart home & building appliances like air
e SMD package delivered in tape and reel purifiers and loT devices
e Advanced compensation and self- e Air quality monitor

calibration algorithms
e Three interface options: UART, 12C, PWM
e Various configuration options

Note: Please refer to “PAS CO2” product pages for all the details related to CYW43012
|_—/i wireless combo (link).
3.4

Xensivi™™M DPS310 - digital barometric pressure sensor

The DPS310 is a miniaturized Digital Barometric Air Pressure Sensor with a high accuracy level and low
current consumption. The DPS310 is both a pressure and temperature sensor. The pressure sensor
element is based on a capacitive principle which guarantees high precision during temperature changes.
The small package makes the DPS310 ideal for mobile applications and wearable devices.

The DPS310’s internal signal processor converts the output from the pressure and temperature sensor
elements to 24-bit results. Each pressure sensor has been calibrated individually and contains
calibration coefficients. The coefficients are used in the application to convert the measurement results
to true pressure and temperature values.

The sensor has a FIFO that can store the latest 32 measurements. Since the host processor can remain
in a sleep mode for a longer period between readouts, a FIFO can reduce the system power
consumption.

Temperature Digital signal
sensor MUX Eeed ADC B & g —_ Digital core — EEIE IR El S — °C/SP
processing
I

Calibration
coefficients

Capacitive
pressure sensor

Memory Voltage
interface regulators

Sensor measurements and calibration coefficients are available via the serial 12C/SPI interface.

Key features

e Operation range o #0.06 hPa (or £0.5 m)
o Pressure: 300 ... 1200 hPa e Temperature accuracy
o Temperature: -40 ... 85°C o #0.5°C
e Pressure level precision e Pressure temperature sensitivity
o 20.006 hPa (or £5 cm) (high- o <05PakK
precision mode) e Measurement time
e Pressure sensor relative accuracy o Low-power mode: 3 ms
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e Average current consumption o Standby
o Low power: 3 pA e Interface
(1 measurement/sec.) o 12C and SPI (both with optional
o Standby: <1 pA interrupt)
e Supply voltage e Package dimensions
o VDDIO:1.2...3.6V o 8-pin LGA
o VDD:1.7...36V o 20x25x1.0

e Operating modes
o Command (manual)
o Background (automatic)

@ Note: Please refer to “DPS310” product pages for all the details related to the product (link).

3.5. OPTIGA™ Trust M

Secured cloud service provisioning — the easy way!

The OPTIGA™ Trust M — OPTIGA - is a high-end security solution
that provides an anchor of trust for connecting IoT devices to the
cloud, giving every IoT device its own unique identity. This pre-
personalized turnkey solution offers secured, zero-touch
onboarding and the high performance needed for quick cloud access. It offers a wide range of security
features, making it ideal for industrial and building automation applications, smart homes and connected
consumer devices.The turnkey set-up with full system integration minimizes design, integration and
deployment effort.

Open Source Host Code for OPTIGA™ Trust M available NOW!

Get host code and documentation (github.com/Infineon/optiga-trust-m)

Customers benefit from a direct communication line to developers and will immediately and directly be
informed of new versions, features and bug fixes. Be it the integration of standard open-source crypto
software libraries or the integration of the host code into other systems — easily possible now. The host
code is licensed under the MIT License.

Summary of Features

e High-end CC EALG6+ (high) certified security controller
o ECC: NIST curves up to P-521, Brainpool r1 curve up to 512
o RSA® upto 2048
o AES key up to 256, HMAC up to SHA-512
o TLSv1.2 PRF and HKDF up to SHA-512
o TRNG/DRNG » 12C interface with shielded connection
e Hibernate mode for zero power consumption
e USON-10 package (3 x 3 mm)
¢ Standard and extended temperature ranges: -40 to + 105°C
e Upto 10 kB user memory
o Protected updates
o Usage counters
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o Dynamic object (e.g. credentials) locking

e Configurable device security monitor

o Lifetime of 20 years for industrial and infrastructure applications

e Cryptographic ToolBox commands for SHA-256, ECC and RSA® Feature, AES, HMAC and Key
derivation

e MIT licensed software framework on GitHub github.com/Infineon/optiga-trust-m

e OPTIGA™ Trust M’s development process is certified according to the security standard IEC62443-
4-1 for industrial automation and control systems, acting as an enabler to achieve component level
certification according to IEC62443-4-2.

Features apply to latest product version.

_% (link).

Ij Note: Please refer to “OPTIGA™ Trust M ” product pages for all the details related to product
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4. System setup using evaluation hardware

41. The PSoC Pioneer Kit

The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-062S2-43012) is a low-cost hardware platform that
enables design and debug of the PSoC™ 62 MCU and the Murata 1LV Module (CYW43012 Wi-Fi +
Bluetooth Combo Chip).

Figure 5: The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-06252-43012)

Note: Please refer to “CY8CKIT-06252-43012 Pioneer Kit” product pages for all the details
|_%i related to the kit (link).

42. EBVIoOT -=Infineon PAS CO2 Evaluation Shield

The EBV-IoT — Infineon PAS CO2 Evaluation Shield (the shield) can be used in a standalone operation
as well as trough Arduino headers. Simple block diagram in depicted on Figure 8. Following please find
brief overview of components of the shield.

EBV-loT — Infineon PAS CO2 Evaluation Shield

USBR s Hub 1zt
DPS310 PAS CO2 DC/DC
UART @ H

Figure 6: Block diagram

The core are Infineon PAS CO2 and DPS310 environmental and barometric pressure and sensors.
Please refer to products pages for more information. The shield is Arduino compatible using Arduino
headers. On the board there is USB connector used for powering the board and PC communication.

The onboard LEDs show basic status details. USB power LED indicates the board is powered up over
USB. The Board power LED indicates sensor power on status. 12C activity LED indicates 12C
communication status.

Multiple jumpers (JB1, JB2, JCS, JUS, JS) offer sensor interface mode selection as well as selection
using either on-board USB bridge interface or external serial interfaces. Solder bridges (SB1, SB2, SB6,
SB7) and “cut” bridges (JU, JE, JEN, JSCL, JSDA) can be used to “hard-wire” configuration using no
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jumpers. Please refer to shield’s quick start guide for more information. Additional Grove and OLED
connectors placeholders allow using Grove 12C extension or OLED displays.

Arduino headers*

Enable and interrupt access pins

*Groove connectors* Board power LED

*OLED connectors* onboard 12V DC/DC circuit
sensor break away board

USB Power LED 7 ‘ e nfi I ] PAS CO2 sensor

Mini board interface pins
12C activity LED k T d - =~ Interface setup jumpers*
UART connection jumper* DPS310 pressure sensor

Arduino headers with PSoC
extension*

* optional configuration (not populated in default configuration)

Figure 7: The EBV-loT — Infineon PAS CO2 Evaluation Shield overview

4.3. EBV-10T — OPTIGA Trust M Evaluation Shield

The EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield (the shield) can be used in a standalone
operation as well as trough Arduino headers. Simple block diagram is depicted on Figure 8. Following
please find brief overview of components of the shield.

EBV-IoT — Infineon OPTIGA™ Trust M Evaluation Shield

2C

USB Hub I

OPTIGA

O

Figure 8: Block diagram

The core of the shield is Infineon OPTIGA™ Trust M secure element. Please refer to manufacturer
product pages for more information. The shield is Arduino compatible using Arduino headers. On the
board there is USB connector used for powering the board and PC communication.

The onboard LEDs show basic status details. USB power LED indicates the board is powered up over
USB. The Board power LED indicates secure element power on status. I12C activity LED indicates 12C
communication status.

Multiple jumpers (J2, JC, JSDA, JSCL) offer additional hardware configuration. Solder bridges (SBRU,
SBVO, SB2, SB6, SB7) and “cut” bridges (JU, JE, JB, JBR, JBSCL, JBSDA) can be used to “hard-wire”
configuration using no jumpers. Please refer to shield’s quick start guide for more information. Additional
Grove and OLED connector placeholders allow using Grove 12C extension or OLED displays.
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Arduino headers SW1 - 12C PROG/EXT switch

*Groove connector* *J2 — RES jumper

*OLED connectors* =g ‘ *JC — current measurement

""" TR jumper

*JSCL, JSDA — External 12C EBVEkHonk

select Pads for wire connection

(compatible with Groove)

OPTIGA

Power LED

USB connector
*Groove connector

- 0 e

(N *PMOD Type 6 (12C slave)
- . Arduino headers with PSoC
extension

*PMOD Type 6
(12C master)

* optional configuration

Figure 9: The EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield overview
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5. Hardware configuration

There are multiple hardware configurations possible for the shields used during the workshop.

5.1. PAS CO2 hardware setup

Note: Please refer to “EBV loT — Infineon PAS CO2 Evaluation Shield - Quick start guide”
oy document for all the details related to the shield

Following please find the configuration setups required for demo to operate.

5.1.1 Out-of-box setup
Shipped configuration is preset to support 12C over USB212C bridge or external I2C communication.

« Configured to be used in 12C mode 22if(a s 22 22aaszsl[aasaanza)
* 12C master can be either
* integrated USB2I2C bridge or

* external 12C master using
external MCU/MPU platform

Evaluation Shield p1.2
" m

» Comes with no through-hole jumpers
populated

T
(3)EBV-loT - Infineon PAS CO2

»

)
A

1. JS - open

2. JB1, JB2 — open (make sure SB1 and

SB2 solder bridges located on bottom

side are open as well)

JUS — no jumper

JCS — 2-3 closed (12C)

5. Make sure SB3 and SB4 solder
bridges located on bottom side are
open

6. Make sure JSCL and JSDA lines
located on bottom side are closed

W

5.2. OPTIGA shield hardware setup

Note: Please refer to “EBV loT — Infineon OPTIGA Trust M Evaluation Shield - Quick start
_j guide” document for all the details related to the shield.
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5.2.1 Out-of-box setup

Shipped configuration is preset to support I12C over USB2I2C bridge or external 12C communication set
by using SW1 switch. Default external 12C pins are set to pins 9 and 10 on CN1. Please make sure the
SW1 switch is set to EXT position.

i< SW1in EXT
position

|
EBV-loT - Infineon OPTIGA Trust M
Evaluation Shield p1.1

o e FOR EVALUATION| @
ﬁ PURPOSES ONLY
ROHS -

@

Figure 10: The secure element shield out-of-box configuration

5.2.2 12C interface configuration (after using any other jumper configuration)
To use default I12C interface configuration on pins 9 and 10 on CN1 set jumpers as shown on Figure 11.

e ' SW1in EXT
i position

EBV-loT - Infineon OPTIGA Trust M | - i - ‘

(™

¥ FOR EVALUATION| @
ﬁ v/ | PURPOSES ONLY
| i 2 a3 333 3“
s 33 2 33333

Figure 11:The secure element shield 12C pins configuration
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6. EBV IoTConnect — Solution Accelerator Software

loTConnect is a Solution Accelerator Software-as-a-Service that leverages existing cloud infrastructure
and its native services such as storage and compute to create a unified 0T experience for solution
designers to easily enable secure device management and develop solutions 50%+ faster than
traditional 10T platforms.

loTConnect is designed to help Original Equipment Manufacturers (OEMs) develop connected solutions
by simplifying the process and decreasing time to market by more than 50%. OEMs can utilize
loTConnect to overcome market pressures with a reliable, secure and scalable solution that will simplify
overall system design and lower the operations and maintenance costs.

loTConnect comes with an easy-to-use interface, powerful device and entity management systems, as
well as built-in analytics allowing OEMs to connect and manage devices with little to no coding.

loTConnect provides businesses with the infrastructure required to connect their assets, collect data and
analyze it to improve decision-making. This is achieved by facilitating device communication and
management while adhering to industry-grade security protocols.

[IOTCONNECT"

loTConnect is created to bring together all the key elements of an loT platform to allow OEMs to
seamlessly connect devices to the cloud and quickly gain insights from the collected data to make better
business decisions. loTConnect deploys applications that are customized for various businesses and
provides benefits such as improved ROI, reduced downtime and a better user experience.

Features

Easy configuration and management Easy integration and connections
» Device registration without any hassle or * Cross-device communication support
programming knowledge Supports different industry-grade protocols

« Multi-tenant archtecture with user and roles * Web services and APIs to
management simplify exchange of

+ Device management (\ -J information
+ Asset management \@ Microservices-based

+ Software management architecture
* Remote troubleshooting * Service SDK
* Over-the-air (OTA) firmware updates

Multi-layer security Edge and predictive analytics

* Enterprise-grade, end-to-end security » Edge analytics to make quick decisions

» Device identity management * Near real-time monitoring with live graphical charts
» Access Security using Device Identity » Extensive real-time streaming analytics

JLs

« Role-based access control » Connectors for data visualization
applications

Management, OAuth 2.0 * Machine learning and statistical
*  Protocol transmission over TLS % algorithms °_/\/_"—°
S v O 2
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Real-time alerts and notifications

* Create smart rules for autonomous actions

* Fully customizable workflows and 000 @
notifications

» Detect anomalies and get alerts
about potential problems —

Note: Evaluating the Avnet loTConnect cloud is completely free of charge for first three
—, months with no restrictions on the platform features. No credit card is required to perform the
registration process.
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7. Task 1. PSoC programming and debugging — Hello world

Ml

3 Important: ModusToolbox™ has to be installed prior running the task. Please refer to sub-

Quick start: Please proceed to step 9 Task 3: OPTIGA™ provisioning for loTConnect Cloud

section 2.2.1 Installing ModusToolbox.

7.1. Overview

In this task we will create a simple “Hello world” project to get familiar with the toolchain.

7.2. ModusToolbox Overview

ModusToolbox™ Software is a modern, extensible development environment supporting a wide range of
Infineon microcontroller devices, including PSoC™ Arm® Cortex® Microcontrollers, TRAVEO™ T2G
Arm® Cortex® Microcontroller, XMC™ |ndustrial Microcontrollers, AIROC™ Wi-Fi devices,
AIROC™ Bjluetooth® devices, and USB-C Power Delivery Microcontrollers.

I?SOCT'V' Creator DAVE

— DAVE™

DAVE™  DAVE™

EXAMPLES

Z0==->»0O0=rvuvo>

i ¢ 4
luation-to-Production (E2P)

»  Software IDE for PSoC™ 3, PSoC™ 4, Free Eclipse-based code development platform/IDE
PSoC™ 5 offering code repository, graphical system design
»  Schematic-based capture tool enables methods, and automatic code generator

custom analog front end and
programmable digital development

> Component-based design with graphical
configuration tools XMC™ Lib DAVE™ generated code is tested and

Modus

Guides XMC™ microcontroller user along the entire
process — from evaluation to production (E2P).

d
released for anduse with 3’ party tool.

7.3. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.
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@ EBVE|ektronik Task 1: PSoC programming and debugging — Hello world
7.3.1 HW setup

In this task we will actually use only PSoC Pioneer Kit, but we recommend using complete stack of
boards as will be required in later tasks. Please check section 5 Hardware configuration for details.

For convenience, stack the Arduino compatible shields in the following order from bottom to top:

e The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-062S2-43012) —
at the bottom

e EBV-IOT — Infineon PAS CO2 Evaluation Shield

e EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield

e 128x128 pixels OLED display (optional)

LED

<7>

RESET button

7.3.2 Launch Eclipse IDE for ModusToolbox
To launch the Eclipse IDE start Eclipse IDE for ModusToolbox 3.1 from Windows start menu under
“ModusToolbox 3.1 (Current user)”

- ModusToolbox 3.1 (Current user)

bsp-assistant 1.10.0
BSP' New
bt-configurator 2.80.0
BT New

i@ capsense-configurator 6.10.0
il capsense-tuner 6.10.0
dashboard 3.1.0

i@ device-configurator 4.10.0

)g dfuh-tool 2.0.0

¥ Eclipse IRI?E for ModusToolbox 3.1 I l

bd ©Z-pa-conngurator 1.21.0

fw-loader 3.5.0

i@ library-manager 2.10.0

configurator 1.21.0
LIN' New

BN modus-shell 1.40

l ModusToolbox 3.1 Documentation

possible. Otherwise, the complete path length may become too long and compilation of some

Important: Itis very important to keep your Workspace and Project names as short as
3 later project may not succeed.

At “Select a directory as workspace” prompt you can either (select one option from the list bellow)
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A. browse for your existing workspace directory clicking ,
B. create new directory by clicking and then inside the File explorer right click and go for

New—->Folder|, name the folder, select newly created folder, and click |Select Folder|,

ﬁ Select Workspace Directory X
4 & » ThisPC » 0S(C) » ~ O O Search 05 (C)
Organize » New folder = - a
Template A Name Date modified Tpe Size "
F Avnet ProgramData File folder
Intel File folder
@ OneDrive - Avnet Temp File folder
[ This PC Al File folder
J 3D Objects Program Files File folder
e File folder
[ Desktop View > §
- File folder
[ Documents Sort by b4 File folder
3 Downloads Group by > File folder
b Music Refresh File folder
| Pictures Paste File folder
B videos Paste shortcut File folder
#2085 (C) Undo Rename Ctri+Z File folder
= Belgrade (Gi) 4] Open with Visual Studic File folder
- 7 File folder
& .. . ¥ = — e
Roices | New > Folder |
S [! m Select Folder Cancel

C. Typein any valid path for your workspace and the tool will create it at if missing,
D. or search among recent workspaces listed when clicking [Recent workspaces|.

Select Workspace Directory and click

Eclipse IDE for ModusToolbox™ Launcher X

Select a directory as workspace

Eclipse IDE for ModusToolbox™ uses the workspace directory to store its preferences and development artifacts.

Workspace: | C/EBV-IoTC ~ Browse...

I:‘ Use this as the default and do not ask again

» Recent Workspaces

==

7.3.3 Create a project

When creating a new workspace or if no project were previously added to the workspace, you will see an
empty workspace as shown below. Click the New Application link in the Eclipse IDE “Quick Panel”.
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N NN N I S S S . .-
EBV-1oTC - Eclipse IDE for ModusToolbox™ DY - o X
Fe Edit Navigate Search Project Run Window Help
ot ey Q |

i R S R R =]
I;mmck Panel (+» Variables & Expressions ®e Breakpoints = 0 % ouline et =0o

(]
- -

B There is no active editor that provides an
Im EBV-10TC - Eclipse IDE for ModusToolbox™ outline
File Edit Navigate Search Project Run Window Help
- | By i v Qi@ v BN C

| Quick Panel = Variables %7 Expressions % Breakpoints ~ O

Eclipse IDE for
ModusToolbox™

& Ref

fresh Quick Panef
I- Project

I'-.
v
- -

o =
~ Launches . -
= New Application
~ Tools

mm [mport Existing Application In-Place
~ BSP Configurators

& Search Online for Code Examples Ik
& search Online for Libraries and BSPs
& Training Material

B Console & [2] Prof —
ModusToolbox™ Con & Refresh Quick Panel

Log file(s) for
- Project

Y
«

- Launches

Alternatively, you can use [File > New 2 ModusToolbox ™| Application or press “CTRL+7".

Q EBV-10TC - Eclipse IDE for ModusToolbox™

r New Alt+Shift+N > [ Project..
T miithar Fa

- DEET IS S T S an= & ModusToolbox™ Application . Cirl+7
Recent Files r |}

These commands launch the “Project Creator” tool with Board Support Package (BSP) selection, which
displays a list of boards, showing the Kit Name, MCU, and Connectivity Device (if applicable). As you
select each of the kits shown, the description for that kit displays on the right. Depending on the settings
for your system, you may see different categories, including PSoC™ 4, PSoC™ 6, and AIROC™
Bluetooth® BSPs. For this example, select the CY8CKIT-06252-43012 kit and click Next|.

E Choose Board Support Package (BSP) - Project Creator 2.10 — m} X

Source Template

Enter filter text... & H Create from MPN... Browse for BSP.. = CY8CKIT-06252-43012 ~

Kit Name MCU/sOC/sIP Connectivity || The CYBCKIT-06252-43012 PSoC™ 652 Wi-Fi BT Pioneer Kit is  low-cost
CYBCEVAL-06252-MUR-4373M2  CYBC624ABZI-52D44 LBEESPK2BC (CYWA373IUBGT) hardware platform that enables design and debug of PSoC™ & MCUs. It
o R ) — comes with a Murata 1LV Module (CYW43012 Wi-Fi + Bluetooth Combo
CYBCKIT-06252-430 CYBC624ABZI-52D44 LBEESOBILY (CYW43012COWKWEG) Chip), industry-leading CAPSENSE™ for touch buttons and slider, on-
CYACKIT 05o%a E CYACA244101,SAN0) nane board debugger/programmer with KitProg3, microSD card interface, 512-

Mb Quad-SPI NOR flash, PDM-PCM microphone interface.

CYSCKIT-062-WIFI-BT CY8C6247BZ1-D54 LBEESKL1DX (CYW4343WKUBG)
CYSCKIT-064B052-4343W CYBOB44ABZI-52D44 CYWA4343WKUBG it Features:
CYSCKIT-0645052-4343W CYSO644ABZI-S2D44 CYWA4343WKUBG
CYSCPROTO-062-4343W CYSC624ABZ1-52D44 LBEESKL1DX (CYW4343WKUBG) * Support of up to 2MB Flash and 1MB SRAM
CYBCPROTO-06252-43439 CY8C624ABZI-52D44 LBEESKL1YN (CYW43439KUBG) * Dedicated SDHC to interface with WICED wireless devices.
CYBCPROTO-06253-4343W CY8C6245LQ1-53D72 LBEESKL1DX (CYW4343WKUBG) ® Delivers dual-cores, with 3 150-MHz Arm® Cortex®-M4 as the
CYACPROTO-NA2-BILE CYRIE-A1ANAS-N2 (CYAr CYRIF-A1ANAS-N2 (CVACAIATRTZI-RI NS 2 primary appllcatlcn processor and a 100-MHz Arm® Cortex®-MO+ ~
Summary: e

BSP: CY8CKIT-06252-43012

Press "Next" to select application.

—
Next > 'QIUSE

Next, “Select application” window is opened listing various applications available for the selected kit. As
you select an application, a description displays on the right. You can select multiple applications for the
selected BSP by enabling the check box next to the applicable applications. In the Project Creator -
Select Application dialog, choose the example by enabling the checkbox. Go to “Getting Started” and
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select check box next to the "Hello World" application. Optionally, you can change the suggested New
Application Name. Click Create to complete the application creation process.

@ Select Application - Project Creator 2.10 - O X
Settings Help
Application(s) Root Path: |C/EBV-loTC Browse...
Target IDE: Eclipse IDE for ModusToolbox™
Enter filter text... £ || Browse for Application... ;,' = =] U[+| |This code example demonstrates a simple UART communication by printing
—= — ~ a "Hello World" message on a terminal and blinking an LED using a timer
Template Application New Application Name  New BSP Name resource. This code example is based on HAL (Hardware Abstraction Layer)
Bluetooth® libraries.

Community Code Examples
Connectivity For more details, see the README on GitHub.
v Getting Started
[] Dual-CPU Empty PSoCé App
mpty App
Hello World MEERTEE  |APp CY8CKIT-06252-43012

[] Switching Power Modes v

Template Application(s): Hello World ~
Application(s) Root Path: C;/EBV-I1oTC

Press "Create” to create the selected application(s).

< Ba Create lose

When you select a supported kit, the example is reconfigured automatically to work with the kit. To work
with a different supported kit later, use the Library Manager to choose the BSP for the supported kit. You
can use the Library Manager to select or update the BSP and firmware libraries used in this application.

To access the Library Manager, click the link from the Quick Panel.

You can also just start the application creation process again and select a different kit.

If you want to use the application for a kit not listed here, you may need to update the source files. If the
kit does not have the required resources, the application may not work.

|j/ Note: For more details about using this tool, refer to the ModusToolbox™ Project Creator
oy user guide.

After several moments, the application opens with the Hello_World in the “Project Explorer”, and the
README.md file opens in the file viewer.

Bl
(w4 ODv{Rvm H#-v0vQv® 490 - B r:divdl v o Q w8
L1 Project Explorer =2 %5 Debug ! Registers 7 Peripherals — T [ READMEmd O & Outline o
v h1. HAL: Hello world
&5 Hello_World s h2. Requirements
5 . ~

&5 mtb_shared h2. Supported toolchains (make val

h2. Supported kits (make variable
This code example demonstrates a simple UART communication by printing the "Hello world" message on a terminal and h2. Hardware setup
blinking an LED using a timer resource. The code example is based on HAL(Hardware Abstraction Layer) libraries. h2. Software setup

s h2. Using the code example
View this README on GitHub. h2. Provisioning steps (Only require
h2. Operation

Provide feedback on this code example. h2. D
ebugging

<

h2. Design and implementation

Req uirements h3. Resources and settings
h2. Related resources
I3 h2. Other resources
* ModusToolbox&trade; software v3.0 or later (tested with v3.0) h2. Document history

+ Programming language: C

« Associated parts: All PSoC&trade; 6 MCU parts, XMC7000 MCU

* PSoC™ 6 board support package (BSP) minimum required version: 4.0.0 or XMC7200 evaluation kit BSP minimum
required version: 1.0.0

&l Quick Panel 1+ Variables & Expressions % Breakpoints

Supported toolchains (make variable 'TOOLCHAIN')

Eclipse IDE for 2
ModusToolbox™ + GNU Arm® embedded compiler v10.3.1 (ccc zzw) - Default value of toorcaain
- Start * Arm® compiler v6.16 (az) v
@ ) * 1AR C/C++ compiler v9.30.1 (123)
q Markdown Source Preview < >
; © Console (£ Problems 5 Progress 2 [ Memory & Terminal %
- No operations to display at this time.
@ T
& Re
~ Project
~ Launches
= Writable Insert 1:1:0
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\O, Tip: It is convenient to have line numbers shown in the IDE. Please go for

- Window->Preferences| now search for “number” or go for |General>Editors>Text Editors|

P4 \ “ H ” H
< and [check| “Show line numbers” and click |Apply and Close.
Preferences O x
number * |} Text Editors - v
v General Some editors may not honor all of these settings. ~
v Editors
Text Editors See ‘Colors and Fonts' to configure the font.
Undo history size: 200

Dlnsert spaces for tabs

Remove multiple spaces on backspace/delete
Highlight current line
[]Show print margin

Displayed tab width:
80

gimyihe margin column

l [~] Show line numkpers L l
atus line v

@ e Apply and Close Cancel

7.4. |IDE overview

The IDE is based on the Eclipse IDE. It uses several plugins, including the Eclipse C/C++
Development Tools (CDT) plugin. For more information about Eclipse, refer to the Eclipse Workbench
User Guide. We also provide a document called the Eclipse IDE survival guide, which provides tips
and hints for how to use the Eclipse IDE.

The IDE contains Eclipse standard menus and toolbars, plus various panes such as the Project
Explorer, Code Editor, and Console. One difference from the standard Eclipse IDE is the
"ModusToolbox™ Perspective". This perspective provides the "Quick Panel", and adds tabs to the
Project Explorer. "Perspective" is an Eclipse term for the initial set and layout of views in the IDE.

[ EBV-1oTC - Hello_World/main.c - Eclipse IDE for ModusToolbox™

- a x
File Edit Source Refactor Navigate Project Run Window Help
B HEIB R Ei%-0 A im B ; » cHesgeroelm Menus & Toolbars a =@
L, Project Explorer 37 4 Debug i Registers % Peripherals — O [ READMEmd ¢ mainc &2 = O & Outline 22 =
- § oL s B SEARY &% E
« & Hello Warld 2 * Return 8 ghalh
il Includes 93 = ind U gybsph
& bsps B cy retarget ioh
& build 6= int main(void) # LED_BLINK_TIMER_CLOCK_HZ
& deps 7 1 # LED_BLINK_TIMER_PERIOD
& ima 18 cy_rslt_t result; H  timer_init(void)
= libs . ) % isr_timer{void*, cyhal_timer_event_
2 mai PI’OjeCt 00 #if defined (CY_DEVICE_SECURE) & timer interupt_lag
uc 61 cyhal_wdt_t wit_obj; & led_blink active_flag
b Mal EXplorer /% Clear watchdog timer so that it doesn't trigger a reset */ ® uartread value
B REA o result = cyhal_wdt_init(Swdt_obj, cyhal wdt_get_max_timeout_ms(}); ® led_blink timer
&5 mtb_sh: CY_ASSERT(CY_RSLT_SUCCESS == result); @ main{void)

cyhal_wdt_free(&wdt_obj); & timer_init{void)
@7 Mendif /* #if defined (CY_DEVICE_SECURE) */

» ¥ isr_timer{void*, cyhal_timer_svent_

/* Initialize the device and board peripherals *
result = cybsp_init(); Code
/* Board init failed. Stop program execution */ .
if (result l= CY_RSLT_SUCCESS) EdItOI‘
& Quick Panel - Variables & Expressions % Breakpoints a
11 CY_ASSERT(8) ;
Eclipse IDE for |
ModusToolbox™ /* Enable global interrupts *
11 _enable_irq();
~ Start 12¢
121 /* Initialize retarget-io to use the debug UART port */ .
! DU To e fhe dehws RRL et 4 . R
© Console (21 Problems = Progress ) Memory  Terminal i1 GO kaEBEnP=0
H B Hello_World ModusShell
Quick
& Refresnd Pannel s
Console

~ Launches

* Hello World Debug (JLink)
‘Connecled - Encodina: Default (1S0-8859-1)

A Tip: If you switch to a different perspective, you can restore the ModusToolbox™ Perspective
O— by clicking the ModusToolbox™ icon button in the upper-right corner. You can also select

= IPerspective > Open Perspective| from the Window menu. To restore the ModusToolbox™
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Perspective to the original layout, select [Perspective > Reset Perspective| from the Window
menu.

The following describe different parts of the IDE:

Menus and toolbars — Use the various menus and toolbars to access build/program/debug
commands for your application. Many of these are covered in the Eclipse Workbench User
Guide.

Project Explorer — Use the Project Explorer to find and open files in your application. See
Project Explorer for more information.

Quick Panel — Use this tab to access appropriate commands, based on what you select in the
Project Explorer. More in Quick Panel sub-section.

Code Editor — Use the Code Editor to edit various source files in your application.

Console — Use these tools to review messages and access the integrated terminal.

7.4.1 Project Explorer

In the Eclipse IDE, after creating an application, the Project

[y Project Explorer 57 4§ Debug il Registers . Periphers

Explorer contains one or more related project folders. The
following images show our “Hello_world” PSoC™ MCU e s
application. » :;l:des
Both PSoC™ MCU application and an AIROC™ Bluetooth® S:p'd
application types of applications contain a similar project structure. = e
Each contains the main application source code, and a Makefile. D;’[TQEQ‘SE
Note that PSoC™ MCU applications contain a libs directory, while Makefle
AIROC™ Bluetooth® applications have a wiced_btsdk project (% mtb_shared
with shared SDK, BSPs, and libraries for all applications in a
workspace.
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7.4.2 Quick Panel
As stated previously, the “Quick Panel” is part of the

" o . . i = | 8- KR -Bi%-0-%-i® 5
ModusToolbox™ Perspective”. It provides quick access to - wVeriables 8 Expresions % Gresipord
commands and documentation based on what you have & Eclipse IDE for

selected in the “Project Explorer”. * ModusToolbox™

. . . . [~ -
The Quick Panel contains links to various commands and ;“
. . Mew Application
documentation, organized as follows: -

E Impert Existing Application In-Place
& Search Online for Code Examples

e Start — This contains the New Application link to create new

& Search Online for Libraries and BSPs

applications, and links to find Code Examples, Libraries, @ Taining Material
BSPs, and training material. & Refresh Quick Pancl
e Selected <app-name> project — This contains different - Hello-World (APFCYSCIIT-06252-43012)

5% Build Application

project-related links based on the project that is selected in
the Project Explorer, as well as the type of application.

f Clean Application

+ Launches
Links here include: Build and Clean the application. #5. Hello_World Debug (Link)

e Launches — This contains various Launch Configurations, 4 Hello World Debug (KitProg MiniProgd)
based on the selected application project and device, g::::: s st
which can be used to program the device and launch the & Generate Launches for Hello_World
debugger. This area is only populated if you have the top « Tools
project in your application selected (<app-name>). e BSP Assistant 1.0

[& Device Firmware Update Host Tool 1.60

e Tools — This contains links to the various tools available for
the selected project. For more information.

[ Library Manager 2.0

= BSP Configurators (APP_CYSCKIT-06252-43012)

¢ Documentation — This may contain several documents in [ CAPSENSE™ Configurator 5.0
HTML format, which are included as part of the chosen i CAPSENSE™ Tuner 50
BSP E Device Cenfigurator 4.0

[& QsPI Configurator 4.0

E Segment LCD Cenfigurater 1.50 (new configurator)
[ Smart 1/0 Configurator 4.0

E USE Configurator 2,50 (new configurator)

w Hello_World Library Configurators

E Bluetooth® Configurator 2.60 (new configurator)

7.4.3 Build application
After loading an application, build it to generate the

necessary files. Select a project. Then, in the Quick K& Quick Panel - Variables & Expressions % Breakpoints 5
Panel, click the Build Application link. The following Eclipse IDE for A
images show the Quick Panel for a typical PSoC™ ModusToolbox™

MCU application. - start

It may take some time to compile, but it only takes so B New Applicaion

much time for the first compile or after “Clean Application” @ comreh Online for Code Examples
execution. In the Console you can follow messages flow & Search Online for Libraries and BSPs

until receiving something like: & Training Materia
& Refresh Quick Pane

& Import Ex sting Application In-Place

14:08:31 Build Finished. © errors, © warnings.
(took 53s.74ms)

= Hella Warld (APP CYRCKIT-04252.43012)
@ Build Application I}
LIS ARPICaUon

~ Launches
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7.4.4 Program application
In the Project Explorer, select the desired project.

. - - Quick Panel ©-Variables % E i “e Breakpoint =0
Then, in the Quick Panel, click the Hello_World K& Quick Panel (¢ Variables &f Expressions % Brealpoints
Program (KitProg3_MiniProg4) link for a PSOoC™ MCU .« ... aopiication ~
appllcatlon ~ Launches
In the Console you should be seeing some messages # Hello World Debug (Link
. : I . » “ . ”» ¥ Hello_World Debug (KitProg3_MiniProg4)
including “Erasing” and “Programming” progress bar and P .
the orange LED on the PSoC Pioneer Kit blinking. | © Hello, World Program (P33 MiniProqs)

enerate Launcﬂes tor Hello_World

~ Tools

BSP Assistant 1.0
Device Firmware Update Host Tool 1.60

Library Manager 2.0

7.4.5 Accessing the device through serial terminal
The “Hello_world” application also sends some data to serial communication interface we can read using

any serial communication terminal. Please use device manager to get your device serial port number
information like the one depicted bellow:

& Device Manage - O x

File Action View Help
e D EHEEIP kXS

~ Keyboards ~

=» Mice and other pointing devices
[) Monitors

@ Network adapters

L Other devices

== KitProg3 USB-UART (COM14)
== USB Serial Device (COM89)

== Processors

B Security devices
@ sensors

-

Use your favorite serial communication terminal for serial communication monitoring. We use TeraTerm
or you can use ModusToolbox integrated serial communication terminal. Use following settings:

e Port number: as retrieved from “Device manager”
e Speed: 115200

e Data: 8 bit
e Parity: none
e Stop bits: 1

e Flow control: none
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For the “Hello_World” example you should be seeing messages as follows (reset board if needed):

L terminal - com14

File Edit Setup Control Window Help

Hello World!!!

For more projects, visit our code examples repositories:

LED blinking paused

Press 'Enter' key to pause or resume blinking the user LED

Fokokokkokokkkkokkokkkkkk HA|l + Hello World! Example 3k 3k >k 3k 3k 3k >k %k >k >k >k >k %k %k %k %k k k

7.4.6 |IDE integrated serial communication terminal

7.4.7 Debug application
One of the most advanced features of the toolchain is

.. . . | Quick Panel =Variables % Expressions e Breakpoints =
definitely step-by-step debugging. In the Project -
Explorer, select the desired project. Then, in the Quick .« ... sosicaton ~
Panel, click the Hello_World Debug - Launches
(KitProg3_MiniProg4) link for a PSoC™ MCU %5 el World Debug (1l ind)
application ¥ Hello_World Debug (KitProg3_MiniProg4)
. . « oy L e
The process is very similar to “Build” process: in the 0 Hello World Program (KitPh353_ MiniProg)
Console you should be seeing some messages including & Generate Launches for Hello_ World
“Erasing” and “Programming” progress bar, but now your E—
application execution will halt at “main” function entrance. BSP Assistant 1.0
& Device Firmware Update Host Taol 1.60
Library Manager 2.0
Q EBV-IoTC - Hello_World/main.c - Eclipse IDE for ModusToolbox™
File Edit Source Refactor Navigate Search Project Run Window Help
e [ ®B~|R-BiH -0~ Qi@ F BN ®N22 . 0 | dmE s~ =]
5 Project Explorer 45 Debug 2 !4 Registers 7. Peripherals ~— O [# README.md [€] mainc 2 [E]0x12a startup_psoc6_02_cm4.S
o k| 8 94 *
~ [E] Hello_World Debug (KitProg3_MiniProg4) [GDB OpenOCD Debug _ 95 T #esmmsmsmmmmmimmmmmmmmmim s s
~ i mtb-example-hal-hello-world.elf EE_ int main(void)
~ o Thread #1 1 (Name: Current Execution) (Suspended : Breakp ! ;\'} { oy rslt t result:
= main() at main.c:97 0x10002930 EC Y- - ’
#5 openocd.exe 100 #if defined (CY_DEVICE_SECURE)
W arm-none-eabi-gdb.exe 1091 cyhal_wdt_t wdt_obj;
:é; /* Clear watchdog timer so that it doesn't trigger a reset */
104 result = cyhal wdt_init(&wdt obj, cyhal wdt get max_timeout ms());
105 CY_ASSERT(CY RSLT SUCCESS == result);
106 cyhal_wdt free(&wdt_obj);
107 #endif /* #if defined (CY_DEVICE_SECURE) */
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Now you could do step by step code execution or eventually run it as in R Window Help

the “Program” example. Please use icons ™ © ® == [= .. & jn the > Resume F8
“Toolbar” menu or check “Run” for all the options. Eventually you can use Suspend
k B Terminate Ctrl+F2
following shortcuts: Disconnect
2. StepInto F5
e F8—Run or Resume ® Step Over o
Step Return F7
e [5-— Step Into <[ RuntoLine Ctrl+R
Use Step Filters
° F6 - Step Over Step Into Selection Ctrl+F5
e CTRL + F2 — Terminate @, Run Last Launched Ctrl+F11
. CTRL + R — Run to Line 4% Debug Last Launched F11
Run History >
© Runhs >
Run Configurations...
Debug History >
% Debug As »
Debug Configurations...
@ External Tools »

OI’
/’ \
|

Tip: The shortcuts above are very handy, especially if you use debugging for longer period of
time.

Note: You may noticed the perspective changed to “Debug” perspective which is more
convenient for application debugging. You can change perspective using
Window->Perspective>Open Perspective>Other| and use any other perspective or switch
to ModusToolbox (default) perspective. You can also select perspective from the Toolbar at

the far right hand side using icon 10

G-

Task accomplished: Congratulations, you have just run your first ModusToolbox application
and learn step-by-step debugging.

<«
|
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8. Task 2: PSoC programming and debugging — Adding sensors

8.1. Overview

In the task we will extend the “Hello_World” application with reading Infineon Xensiv sensors through 12C
buss and display the values in the terminal. We will copy existing project, include additional libraries for
PAS CO2 and DPS310 sensors, and change the “main.c” file content.

8.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

8.2.1 HW setup
Hardware setup shall remain same as in the previous task as shown in sub-section 7.3.1 HW setup.

8.2.2 Create a project
Assuming your Eclipse IDE for ModusToolbox is still open from the previous task.

ModuToolbox (default) perspective.

3 Important: Terminate previous debug session (if still running) and switch perspective to

In the Project Explorer [right click| on “Hello_World” project and click [Copy|.

Q EBV-10TC - Hello_World/main.c - Eclipse IDE for ModusToolbox™

File Edit Source Refactor MNavigate Search Prgject Run Window Help
O B~ | ~mits~0~Q~-i® s ~iBi LI Y S
E5 Project Explorer 52 %% Debug #! Registers % Peripherals = O README.md [¢ mainc 2 [0
B%Y § 94 %
A -LDCHEIID VI’_.IJ 95 O OR R R R R OR RO R RO
= 37 (&l ’ 96= int main(void)
Go Into 97 {
Incl
Bl Incly i . 98 cy_rslt_t result;
& bsps Open in New Window a9
= builc Show In Alt+Shift+W > 00 #if defined (CY_DEVICE !
= deps ModusToolbox™ ¥ a1 cyhal_wdt_t wdt_obj
= imac Show in Local Terminal > 82
= libl e a3 /* Clear watchdog t
Em 1 Copy [,\\3 M ket 84 result = cyhal_wdt_
= LICEI ol e a5 CY_ASSERT(CY_RSLT_S
- K Delete Delete 06 cyhal_wdt_free(&wdt
L& Maks Source > 07 #endif /* #if defined (
[ REAI 2 o)
EBV-IoT — Infineon loTConnect Secure Cloud connected solution - Training Manual ver 1.4 47 of 88

{2y


https://www.avnet.com/wps/portal/ebv/

@ EBVE|ektronik Task 2: PSoC programming and debugging —Adding sensors

I An Avnet Company |

Now [right click| anywhere in empty space inside Project Explorer and click [Pasté].

EBV-1oTC - Hello_World/main.c - Eclipse IDE for ModusToolbox™

File Edit Source Refactor Navigate Search Project Run Window Help

M- | B~R B HF~O -~ ® &~ B0 8 o

[£5 Project Explorer £ 4% Debug ¥4 Registers 7. Peripherals — O  [#] README.n
BES% Y § 94

~ 125 Hello_Wor] 95 REEEH
# Binaries > jnt m
to

[l Includes q
& bsps Open in New Window

& build Show In Alt+Shift+w > fF d
=1 fjePS ModusToolbox™ 2 9
(= images Show in Local Tggmioal >

= libs

[& main.c E
= LICENSE d
Lf Makefile Source > fendi

You will be prompted for new Project name. We will use “Hello_World_Sensors” but can be any name

you like until it is kept short. Then click [Copy]. In the Project Explorer you shall now see
“Hello_World_Sensors” project.

[ Copy Project O = &5 Project Explorer 52 4% Debug ¥ Registers 7, Peripherals = O
BES% 7 ¢

Project name: Hello_WorId_Sensors| ~ =5 Hello_World

# Binaries

kil Includes

Location: | C\EBV-loTC\Hello_World_Sensors Browse... = bsps I}
= build

= deps

= Images

= libs

@ Copy Cancel [ main.c

|2 LICENSE

L& Makefile

l =% Hello_World_Sensors

Use default location

Chaoose file system: |default >

It is strongly recommended to close all the files on Code Editor. Right click| on any of the file names in
Code Editor and click |Close All|.

ﬁ EBV-1oTC - Hello_World/main.c - Eclipse IDE for ModusToolbox™
File Edit Source Refactor Mavigate Search Project Run Window Help

mif g | Br R RO~ Qi@ D0 w2 S PR E TiEyfHyod oo |2
&5 Project Explorer %2 %% Debug ¥V Registers 2, Peripherals — B [ READMEmd [Efmaind &2 Tel0x12a 18] startun nsnc6_02_cm4.S
B 7T 3 g4 * Close
- .bc Hello World g5 e e e e ok R OK e R R OROR R Close Others fic 2k 3 e K HE e i o K e e o o oK e R ROk R Rk R
#¥ Binaries 96=int main(void) Close Tabs to the Left
! Includes o7 4l ight,
cy_rslt t
& bsps Close All [\
& build 100 #if defined (C e
= deps cyhal_wdt_

In the Project Explorer select “Hello_World_Sensors” project, go to Quick Panel to look for
LLaunches for Hello_ World_Sensors| and click to create launches for the new project. You should now
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see updated launches in the Quick Panel as well as “HAL: Hello world”.”"README.md” file is being
opened in the Code Editor.

[ Quick Panel (9=Variables & Expressions ®s Breakpoints = a

« Clean Application

= Launches

- Hello_World_Sensars Debug (JLink)

- Hello_World_Sensars Debug (KitProgﬁgMiniProgdf)
[¥] Hello_World_Sensors Program (JLink)

@ Generate Launches for Hello_World_Sensors

~ Tools

G pep acci 10

Now open the “Hello_World_Sensors” project and double click “main.c”.

EBV-loTC - Hello_World_Sensars/main.c - Eclipse IDE for ModusToolbox™
File Edit Source Refactor Navigate Search Project Run Window Help

B-HR B~/ ~Ri#F~0~ AU~ ®F-DPIENES RSB SSIRETE-F ooy~
i Project Explorer 22 %% Debug % Registers & Peripherals ~— O  [% README.md [€ main.c
B%Y & 18/

]

* File Name: main.c

~ % Hello_World_Sensors

Description: This is the source code for Hello World Example using HAL APIs.

> &Y Includes

(e RN = R RNV
® O OH K XK

Related Document: See README.md
> = bsps
> & build
> (= deps 9
> = images 10 Copyright 2822-2023, Cypress Semiconductor Corporation (an Infineon company) or
11 an affiliate of Cypress Semiconductor Corporation. All rights reserved.
b [ main.c ,12 . . . .
13 This software, including source code, documentation and related
14 * materials ("Software") is owned by Cypress Semiconductor Corporation

®
®
®
*
*
Lo Makefile 15 * or one of its affiliates ("Cypress") and is protected by and subject to
[ README.md 16 * worldwide patent protection (United States and foreign),
> 5 mtb_shared 17 * United States copyright laws and international treaty provisions.
* Therefore, you may use this Software only as provided in the license
* agreement accompanying the software package from which you
* obtained this Software ("EULA").
* If no EULA applies, Cypress hereby grants you a personal, non-exclusive,
* non-transferable license to copy, modify, and compile the Software
* source code solely for use in connection with Cypress's
®

FFA s m i = . &Ar s @8 mo_ i _ra = A 21 inteorated rircunit neadoctc Arr raneaduction madificatinn tranclatinn

Next please click on |Library Manager 2.0| located in Quick Panel:

|l Quick Panel ©-Variables 4 Expressions ®s Breakpoints ~ U

Q Hello_World_Sensors Program (KitProg3_MiniProg4) A

%, Generate Launches for Hello_World_Sensors

~ Tools

BSP Assistant 1.0

When opened click
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Library Manager 2.0 - O X

Application Directory: C:/EBV-loTC/Hello_World_Sensors Browse...

|Eﬂe'f ter text B

Na/r\'ne Update Available Remove ™

v BSPs

@ APP_CYBCKIT-06252-43012 (ACTI... il
v Hello_World_Sensors Libraries

catlemOp

cmsis

core-lib

cor

Lo b P LB

Add BSP Add Library

Requested to add the asset ‘'mtb-hal-cat1" ~
Requested to add the asset ‘'mtb-pdl-cat1"
Requested to add the asset 'recipe-make-catla’.
Requested to add the asset ‘cmsis’.

Found direct dependencies retarget-io”.

Update Close

@

In the Add Library — Library Manager 2.0 please look for “sensor-xensiv-dps3xx” and “sensor-
xensiv-pasco?2’ libraries and check the checkbox int front to get like following and click :

Add Library - Library Manager 2.0 % X

Target Project: | Hello_World_Sensors

|E nter filter text ‘ T B sensor-xensiv-pascol
- H ~
Name Version This library provides functions for interfacing with the XENSIV™ PAS
[ sensor-light 1.1.0 release €02 Sensors. By leveraging photoacoustic spectroscopy (PAS),
[] sensor-motion-bmi160 1.1.1 release XENSIV™ PAS CO2 overcomes the size, performance and assembly
[] sensor-orientation-bmx160 1.0.1 release challenges of existing CO2 sensor solutions. This library can be setup

_ _ to use the ModusToolbox™ HAL interface, or using user provided
sensor-xensiv-dps3xx 1.0.0 release communication functions.

Sensor-xensiv-pasco2 1.1.0 release

— Version details: 1.1.0 release
[] thermistor 2.1.0 release
[] xensiv-radar-sensing 1.1.0 release
Utilities
Voice v

Cancel

At Library Manager 2.0 window please cluck Update| and wait to retrieve all the needed libraries. It may

take some time... When Close gets enabled click . You should notice added libraries in the
“mtb_shared” folder in Project Explorer.

5 Project Explorer 32 4% Debug % Registers = Peripherals = O
=R-
(= images ~
= libs
[¢ main.c
|2 library-manager.log
|2 LICENSE
L& Makefile
[¥ README.md
~ &5 mtb_shared
(= catlemOp
(= cmsis
(= core-lib
(= core-make I}
(= mtb-hal-cat1
(= mtb-pdl-cati
(= recipe-make-catla
g
(= sensor-xensiv-dps3xx
(= sensor-xensiv-pasco2

Since the “main. c” did not change at all and to add sensor readings, we have to add sensor reading
functionality to the code. To keep it easy we provided the updated “main.c” file in
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“Sources/Hello_World_Sensor” folder in the training material. There are multiple options to replace the
content in the “main.c” file:

A. |Right clickj on “Hello_World_Sensors” project at Project Explorer and select Import
At Import prompt select General->File System and click Next

mport =]
Select

i
Import resources from the local file system into an existing project. u

Select an import wizard:

‘ type filter text |

v [= General
W Archive File
Iy e T TR pate
C File System N

2 Projects from Folder or Archive hd

@ < Back Finish Cancel

for the Sources->Hellow_World_Sensors in the training material and use [Select Folder),
Tick “main.c” and click .

m}
File system

X
/
Import resources from the local file system. |

Browse...

From directory: | D:AEBV-loT-IFX_loTConnect_training\Sources\Hello_World_Sensors j

‘ [m] = Hello_ World_Sensors ¢l main.c ‘

Filter Types... Select All Deselect All

Into folder: ‘ Hello_World_Sensors Browse...

Options
[] Overwrite existing resources without warning
[ Create top-level folder

Advanced >>

@ < Back Next > Finish N Cancel

When prompted for “Overwrite ‘main.c’ ... ?” click [Yes| or [Yes To All|.

Ie' Overwrite 'main.c’ in folder ‘Hello_World_Sensors'?
<

Yes I Yes To All No No To All Cancel

B. In Windows Explorer replace the existing “main.c” with new “main.c”, i.e. Copy-Paste new “main.c”

file to “{Your workspace}/Hello_World_Sensors” and confirm |Rep|ace the file in the destination|.
C. Drag and drop the new file from Windows Explorer to “Hello_World_Sensors” project at Project

Explorer, when prompted select Copy files|, and click .
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Select how files should be imported into the project:
@ Copy files
(O Link to files

Create link locations relative to: |PROJECT_LOC

Configure Drag and Drop Settings...

? [ oy |
C,l OK [ Cancel

When prompted for “Overwrite ‘main.c ... ?” click (Overwrite] or Overwrite Al

Question >

'@' Overwrite Hello_World_Sensors/main.c?

Dverwrite All Don't Overwrite Cancel

D. Copy-Paste: Copy the content of the “{training material}/Sources/Hello_World_Sensors/main.c”
file content and Paste — make sure to overwrite all content — it to
“{your workspace}/Hello_World_Sensors/main.c” file using your favorite text file editor.

If all goes as expected, in the “main.c” file in Code Editor you should be seeing two “xensiv” includes in
lines 45 and 46 as shown bellow:

EBV-10TC - Hello_World_Sensors/main.c - Eclipse IDE for ModusToolbox™
Eile Edit Source Refactor Navigate Search Project Run Window Help

=i | B~ R>EBiH~O~ Q- Oy~ Dinmd e TS g bv §lv®oct w0t
[t Project Explorer 52 4% Debug i Registers &, Peripherals ~ O [s] README.md [€ mainc &2
BE% Y & 37 * including Cypress's product in a High Risk Product, the manufacturer
S Hello_World ~ 38 * of such system or application assumes all risk of such use and in doing

« ES Hello_World_Sensors 39 * so agrees to indemnify Cypress against all liability.
> Binari a0 /
L1 Imlarclies an
&) Includes 12l 42 #include "cyhal.h"

& bsps 43 #include "cybsp.h"

(= build 12l 44 #include "cy retarget io.h"

(= deps 12 45 #include "xensiv_pasco2 mtb_h"

(= images 2/ 46 #include "xensiv_dps3xx_mtb.h"

& libs 3;

Q_E main.c 95/

|2 library-manager.log 59 * Constants

B LICENSE 51 /

Now in Quick Panel click Hello World_Sensors Debug (KitProg3 MiniProg4)|, wait for project to

compile, build, program...

[ Quick Panel )= Variables 5 Expressions % Breakpoints =B

o Clean Application

~ Launches

£ Hello_Wogd_Sensors Debug (KitProg3_MiniProg4)

T OLINR)

o Hello_World_Sensors Program (KitProg3_MiniProg4)

% Generate Launches for Hello_World_Sensors

~ Tools

then click Run>Resume| or press F8 and check serial communication terminal... you should be seeing
messages like bellow:
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a Terminal — COM14

File Edit Setup Control Window Help

sk sk sk sk ok ok sk sk sk sk ok ok ok ok sk sk ok ok ok ok sk sk sk sk ok sk sk sk ok sk ok ok okokk sk ko

EBV-IoT - PAS CO2 Demo
PSoC 6 MCU, I2C, PAS CO2, DPS31@, OLED

sk sk sk sk 3k ok sk sk sk sk ok ok ok ok sk sk ok ok ok ok sk sk sk sk ok sk sk sk ok sk sk ok okokok sk ko

>> Configuring I2C Master..... Done

Press 'Enter' key to pause or resume blinking the user LED

Cco2: : 1816 ppm
Pressure : 992.38 mbar
Temperature: 26.14 °C
Cco2: : 1800 ppm
Pressure : 992.37 mbar
Temperature: 26.14 °C

In previous step your learned how to step-by-step debug application. In this step you can explore further
by checking included libraries. You can check the code through browsing “mtb_shared” folder in Project
Explorer or...

A, Tip: Inany of the “.c” or “.h” files you can explore elements like functions, defines or variables
O- by holding “CTRL” button, hoovering over the element, and clicking on it. It will take you to

> either the definition or declaration of the respective element.
Task accomplished: Congratulations, you copied your first “Hello_World“ project, added new
v= libraries and extended functionality sensor readouts through 12C bus.
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9. Task 3: OPTIGA™ provisioning for loTConnect Cloud

Important: This task requires access to loTConnect cloud platform using your loTConnect
! credentials. Software prerequisites 2.3 Create loTConnect cloud account has to be completed
— N prior.

9.1. Overview

In this task we will learn how to use OPTIGA™ Trust M secure element — OPTIGA — using provided tools
by Infineon (link). We are going to use OPTIGA’s unique ID and pre-provisioned certificate with a self-
signed certificate to enable mutual TLS authentication with the Avnet loTConnect cloud.

It is of a great importance for each 0T device getting unique identity linked with unique device certificate.
Most of the time knowing the data is coming from the device we expect is more important than eventually
preventing the data to be read.

OPTIGA consists of various objects which can be accessed for read/write using its Object IDs — OIDs.
Objects can be Common Data such as Coprocessor UID, counters; Cryptographic Keys and Data
objects such as unigue AES key, ECC/RSA private keys and X.509 Certificates; or Application specific
data objects using for various implementations.

0:;;6(:0 0xEQFO OxEQEQ
O CeEocs | OxEOF1 | | OXEOE1 |
COP;':E:E;UID Sec l\él::gggr;unf o =
Slee%i;;;; o E:;Z;i(édzes OxEOF3 OxEOE3
“veocs | melaoein
OXEOFC OXEOES
OxEOFD OXEQE9

read Type 2, 1500Bytes

only 0xF1EO, OxF1EL
LesA

- max 600k max 1.6M OXE1CO

Figure 12: OPTIGA objects map

Endurance indication

In our implementation we use following objects:

e Coprocessor UID (OXEOC?2) — for unique device ID extraction

e X.509 certificate (OXEOEQ) — as a main certificate

e Application specific data object 1 (0OxF1D2) — to store “ENV” value
e Application specific data object 2 (OxF1D3) — to store “CPID” value

Using secure element such as OPTIGA provides the OEMs with following benefits:

e Optiga pre-provisioned — avoiding additional provisioning step during production
e Anti-cloning protection (we only allow known devices to be accessing our system).
e There is no third-party in the personalization process — only trusted authorities involved
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Note: A self-signed certificate is a type of digital certificate that is issued by the entity itself

_/ rather than a trusted third-party certificate authority (CA). In the context of computer security
and encryption, a digital certificate is used to verify the authenticity and integrity of a website,
server, or application.

When a website or server presents a digital certificate signed by a trusted CA, it provides
assurance to users that the entity they are communicating with is legitimate and can be
trusted. The CA acts as a trusted third party that verifies the identity of the entity and signs the
certificate to confirm its authenticity.

In the case of a self-signed certificate, the entity generates its own certificate without involving
a CA. This means that the certificate is not backed by a trusted third party and has not
undergone the same level of verification. Consequently, self-signed certificates are not
automatically trusted by web browsers or other software that relies on certificates for secure
communications.

Self-signed certificates are commonly used in development or testing environments, where the
purpose is not to establish trust with external users but rather to enable secure communication
within a controlled environment. They can also be used for personal or private networks where
the users are aware of the self-signed nature of the certificate.

9.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

To provision the OPTIGA™ Trust M secure element, it is necessary to get specific detail/s related to your
loTConnect cloud account:

1. Company ldentifier.

9.2.1 Retrieve loTConnect cloud account details
Please login loTConnect cloud using your loTConnect cloud credentials - https://avnet.iotconnect.io.

Avnet / 10TConnect

/I\VNE T/ 01cOoNNECT

Welcome back,

Please login to your account

o
m

From the left hand side menu, click [Settings — Company Profile| and notice Company Name and CPID
(Company Identifier). Those details will be required when configure the secure element in the next step:
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_ lOTConnect x ar

CcC O # avnetiotconnect.io,

NVNET @ rowens [ omtcoss @ G s - @ @

Home / Settings / Company Profile
Company Details “
Company Name: EBV IF ) Contact N
I\V N E T Address: Dunajska 167 Fax:

Admin Detail “

Email ID:

Custom rieis

Value

NAVNET otconnecT

You can click O button to easily copy your CPID.

9.2.2 Edit OPTIGA programming script

In provided workshop material please locate “EBVIoT-OptigaTrustM-program.py” script file located in
“Scripts” folder and open it using your favorite Python script editor. Eventually any text editor would just
work fine.

Locate line starting with “CPID” and replace the value between the single quotes with CPID value
retrieved from previous step.

EBVIoT-OptigaTrustM-program.py

File Edit Format View Help
#!/usr/bin/env python

import optigatrust as optiga
from optigatrust import objects

from OpenSSL.crypto import load_certificate, FILETYPE_PEM
import base64

CONOUVT A WNER

from optigatrust import port
import json

(o]

10
11|ans = ""

L2 LNy =D aviictpuoc

13 [CPID = b'xx805f4fba2e43a984c052933612adfl’

| 15 | #UID
Save the script.

9.2.3 Program the secure element
To Do: We will program the secure element using prepared scripts. To get more into the
secure element itself we recommend checking following:
o »EBV-I0T - Infineon OPTIGA Trust M Evaluation Shield - Quick start guide« available
in documentation folder
¢ Infineon »python-optiga-trust« github pages (link)
e OPTIGA Trust M github page (link)
Connect the “EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield” to a PC using micro USB cable
(Type A/ Micro B or Type C / Micro B). Both RED LEDs should be on as shown on Figure 13. SW1
switch should be in PROG position.
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-, Note: You can connect OPTIGA shield to your PC while remaining stacked. Just make sure
== I the USB is plugged to the OPTIGA shield.

Important: To access secure element on 12C bus from the USB2I2C interface SW1 switch
: I should be in PROG position.

position

<7>

Figure 13: Connecting the OPTIGA shield to a PC
Next please run “modus-shell” or your instance of Python.
Note: We use “modus-shell” as a part of ModusToolbox™ toolchain. You can use Python as
_% you toolchain of choice for following steps, too.

Go to a location of the previously edited Python script using command “cd {path}” where {path} is the
location of the script. Use “TAB” key for autocompletion. Next please run the script using command
“./EBVIoT-OptigaTrustM-program.py”

/cygdrive/d/EBVTraining/Scripts
user@computer_name ~
$ cd d:EBVTraining/Scripts

user@computer_name /cygdrive/d/EBVTraining/Scripts
$ ./EBVIOT-OptigaTrustM-program.py
Loaded: liboptigatrust-libusb-win-amd64.d11

Unique Id:
zRYzZTQEAHABFAAAKCRtcABUASQBOgBA

Device Certificate Thumbprint:
226c9215818dfb5f305fe8d378668eb7f2fc1d85

Device Certificate:

Saving certificate file: device_zRYzTQEAHABFAAAKCRtcABUASQBOgBA.pem

user@computer_name /cygdrive/d/EBVTraining/Scripts

- editor, use mouse to mark the value to be copied and use either of the options:

\O, Tip: You will need device’s Unique ID for the future reference. To copy any value from the
r=" e Press “Enter”

L J
e Use mouse right click
Or you can extract the value from the certificate name at any stage later on.
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Note: There is certificate — “pem” file generated and saved into the “../Script” folder which you
— will need in the following steps.

9.2.3.1 Troubleshooting
Most common mistake when interfacing OPTIGA is either the shield not properly connected to PC or
OPTIGA not detected on the 12C bus. There are two possible reasons for the 12C bus detection issue:

1. The shield switch “SW1” is in a position “EXT” - please put the switch “SW1” to position “PROG” as
shown on Figure 13: Connecting the OPTIGA shield to a PC.

2. The I12C bus is taken by external 1I2C master, or the pins are not in “open-collector” mode i.e. pins are
externally held to low or high. = please release the pins. Disconnecting the shield form any other
Arduino interface usually solves the issue.

If you see “Error: 0x102” it is very likely OPTIGA not seen on 12C bus, while only “Error: 0x202” listed,
indicates an issue with shield to PC connection.

user@computer_name
$ optigatrust.exe object --id ©xe@ed
Error: 0x102

II'Error in opening serial port : 2Error: 0x202

Could not find module 'D:\Infineon\ModusToolbox\tools_3.0\python\lib\site-
packages\optigatrust\csrc\lib\liboptigatrust-i2c-win-amd64.d11l' (or one of its dependencies). Try
using the full path with constructor syntax.

libusb: Failed to connect

uart: Failed to connect

i2c: Failed to find library liboptigatrust-i2c-win-amdé64.dll in
D:\Infineon\ModusToolbox\tools_3.0\python\lib\site-packages\optigatrust\csrc\lib

user@computer_name

$

9.2.4 Get QR code for seamless device onboarding
For one of the later steps of adding device to an end user account one of the most convenient ways is to
use QR code to scan for provisioning. Like programming the secure element, we will run another script
for QR code generation. Please run the script using command “. /GetOptigaQR.py”

/cygdrive/d/EBVTraining/Scripts
user@computer_name
$ cd d:EBVTraining/Scripts

user@computer_name

$ ./GetOptigaQR.py
Loaded: liboptigatrust-libusb-win-amd64.d11

Unique Id:
zRYzZTQEAHABFAAAKCRtcABUASQBOgBA

user@computer_name

$
After running the script, the QR code should be opened using any image viewer as well as the

“gqrcode001.png” file is left in the “Script” folder of the training material for your use in later steps.

Task accomplished: Congratulations, you have just programmed Optiga, extracted

y= certificate, and created QR code for further use. You will need “Unique ID” and “Thumbprint”
values in next step.
EBV-IoT — Infineon loTConnect Secure Cloud connected solution - Training Manual ver 1.4 58 of 88

{2y


https://www.avnet.com/wps/portal/ebv/

€ EBVEektronik Task 4: Create a device in loTConnect Cloud

I An Avnet Company |

10. Task 4: Create a device in loTConnect Cloud

Important: This task requires access to loTConnect cloud platform using your loTConnect
! credentials and secure element programmed. 2.3 Avnet loTConnect cloud platform account

— N and Task 3: OPTIGA™ provisioning for loTConnect Cloud have to be completed prior

respectively.

10.1. Overview

In the previous task, the OPTIGA™ Trust M secure element has been programmed with a »Company
ID« and on top of that we use certificate »thumbprint« to connect and authenticate to your loTConnect
cloud account. The device resource must also be created in the cloud before the device is allowed to
connect.

A certificate thumbprint, also called a fingerprint, is a hash of a certificate, computed over all certificate
data and its signature. Thumbprints are used as unique identifiers for certificates, in applications when
making trust decisions, in configuration files, and displayed in interfaces.

10.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

Before creating a new device, it is necessary to create the corresponding device template. A template
defines the JSON data structure that a device can report. Typically, it is used to provide a description of
the sensors present on the board and its corresponding data types. Adding the device template needs to
be done just one time.

Please go to [Devices/Device| page as depicted bellow:

_ I0TConnect X +

C ¥ @& avnetiotconnectio

AVNET

loT Dashboard

ﬂ loT Dashboard

Command , X » Twin ; . Subscription

—— Plan
Devices 8 o EBV Dev Plan

User
30/100

Device Counter

15

Total

Certificates

Notification X . Events
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At the bottom menu click and then click [Create Template| button:

_ lOTConnect X -+

C {r @& avnetiotconnectio
I\ V N E T ﬂ loT Dashboard == Dashboards v 9 Create Dashboard 1 4 ? A v

Home / Overview / Device / Templates

Templates Filter: None V'Y
Name - Auth Type Message Version Attribute Twin Property Command Device Rule Direct Method Actions
No template exists

% Teﬂplates k} 1 2§ Commands a Rules ﬁ Firmware E Batch Import ET Data Export

It is possible to define the device template manually, nevertheless a faster solution is to click
button and select the template.

_ lOTConnect X +

C' (¢ @& avnetiotconnectio
NAVNET

Home / Overview / Device / Templates

€« Create Template m

Template Code: Template Name:" Authentication Type: Device Message Version:*

ﬂ loT Dashboard == Dashboards 0 Create Dashboard

Token v 10 v

Note: We recommend you to use CA signed ¢

ertificate and TPM for production env

B&j Templates 4 Devices Commands B Rules ® Firmware 5] Batch Import [ Data Export

At “IMPORT” pup up window for “EBV-10T Xensiv Demo v1.1_template.JSON” file from
workshop material and finally click button:
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1. All keys are case-sensitive.
2. Supported outhType : 1- Token, 2 - x509, 4 - TPM, 5 - Symmetric Key
3. a. Supported type (datatype) : NUMber & string
b. Supported type (datatype) for 21 bit. boolean, date, datetime, decimal,
integer, latlong, long. object, string & time
4._You can set only cne command as OTA command
5. Attribute Coler should be in Hex Color Code format (Example : #000000].
6. Json property "responseTimecut” in Direct Methed is in second

Download Sample Template File

EBV-IT - Infineon Xensiv Demo v1.2_template. JSON M Browse

m

[N v

You should be seeing template details as shown on figure bellow as well as the template should now be

listed under Templates|.

10TConnect x +

C [ 2% avnetiotconnect.io/templa

AVNET

Home / Overview / Device | Templates

-
.! Dashboards » e Create Dashboard

& 107 Dashboard

€ Edit Template

emplate Code:* emplate Name: Authentication Type: Device Message Version:

Note: We recommend you to use CA signed certificate and TPM for production environments.

Properties Aftributes (7) Twin property (1) Commands (3) Direct Methods (Q)

-

Description Data Frequency (In Seconds]

EBWIaT - Infinean & Avnet loTCannect Secure Claud connected solution 60 “ m

File Support(@)

B Rules & Firmware 5] import History [ Data Export

B Templates Commands

@ Devices

Now browse to devices list using either left hand side menu [Devices — Device menul| or directly clicking
on at the bottom menu. As no devices were created so far we see no device on the list. Click
ICreate Devicel button located on the upper right hand side.
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_ lOTConnect X +

C (¢ @ avnetiotconnectio

AVNET

ﬂ loT Dashboard i! Dashboards » e Create Dashboard f:' ? ‘ v

Home / Qverview / Device / Devices
Devices Filer: None 3/ ¥ a

Unique ID Entity Last Connection Last Communication Device Status Statu

Template

No Device Exists

@ Devices

& Firmware

a Rules

E Templates f!"} Devices Commands E Batch Import E,’ Data Export

The new device will be defined as following:

¢ Unique Id: each device must have Unique ID associated with. We use first 31 characters from
“base64” representation of OPTIGA’s Coprocessor UID

Important: Use “Unique Id” extracted during secure element programming in subsection 9.2.3
3 Program the secure element.

¢ Display name: a friendly name to reference the device (can be anything)

o Entity: select the default entity that was created (usually only one value possible for your instance of

loTConnect cloud)

e Template: select the “EBV-I0T - Infineon Xensiv Demo v1.2” that has just been imported

e Notes: can be anything

e Device certificate: Browse for device’s “pem” certificate

Important: Use device “pem” certificate extracted during secure element programming in
1 I subsection 9.2.3 Program the secure element.
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_ |OTConnect X +

C M 2% avnetiotconnect.io/device/1/add

AVNET

Home [/ Overview [ Device / Devices

0 Create Dashboard

B Dachboards +
- Dashboards

€ Create Device

G Uras Xensiv Dema e
Entity emplate
EBV IFX Training GEEV IaT - Infineon Xensiv Demo v1.2 o

ce Certificate:* @

device_zRYzkwEAHAAFAAAKASCXAADAKOBCY... LB o-.:;;-:e

B Templates i} Devices Commands B Rules & Firmware 5] Import History [2 Data Export

Click button.

You should be seeing “Device created successfully” and device listed in the device view:

IOTConnect X +

C (¢ @& avnetiotconnectio

NAVNET
Home / Overview / Device / Devices

Devices Filter: None Y ¥»

-
.= Dashboards « 0 Create Dashboard

ﬂ loT Dashboard

Unique ID Name - Template Entity Last Connection Last Communication Device Status Stat

O zRYZTQEA Uros Xensiv D @ EBV-IaT EBV IFX Tr NA NA ® Acl

B Templates @ Devices Commands B Rules & Firmware 5] Batch Import [ Data Export

Task accomplished: Congratulations, the device has now been properly setup and is ready

v= to authenticate to the loTConnect cloud.
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11. Task 5: Getting hardware ready for loTConnect cloud

Important: This task requires device created in your instance of loTConnect cloud platform.
Task 4: Create a device in loTConnect Cloud has to be completed prior.

|
—r
11.1. Overview

In this task we will learn how to import existing solution, apply minor code change, and adjust WiFi
settings.

E/ Note: All the settings related to your loTConnect cloud instance are provisioned in the secure
= element.

11.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

11.2.1 HW setup

Before continuing, make sure that EBV-10T — Infineon OPTIGA Trust M evaluation shield 12C switch
is on EXT position. Make also sure that EBV-I0T — Infineon PAS CO2 Evaluation Shield is set to 12C
mode. Please check section 5 Hardware configuration for details.

For convenience, stack the Arduino compatible shields in the following order from bottom to top:

e The PSoC™ 62S2 Wi-Fi BT Pioneer Kit (CY8CKIT-06252-43012) —
at the bottom

e EBV-IOT — Infineon PAS CO2 Evaluation Shield

e EBV-IoT — Infineon OPTIGA Trust M Evaluation Shield

e 128x128 pixels OLED display (optional)

<7>

RESET button

Important: Terminate previous debug session (if still running) and switch perspective to
! I ModusToolbox (default) perspective.

Quick Start: Please jump to section 12 Task 6: Flashing device firmware using “hex” firmware

}}I fle.

EBV-IoT — Infineon loTConnect Secure Cloud connected solution - Training Manual ver 1.4 64 of 88

{2y


https://www.avnet.com/wps/portal/ebv/

@ EBVE|ektronik Task 5: Getting hardware ready for loTConnect cloud

I An Avnet Company |

11.2.2 Import project

In the Elcipse IDE for ModusToolbox in your existing workspace we will import existing project to simplify
the process of application development. Most of the time this is the case how you start developing your
project and added functionalities of your choice.

There are multiple ways of importing projects:

A. Goto Toolbar menu and select [File->Import].
B. Or|[Right click| on empty space of Project Explorer and select Import]

When Import — Select window prompted select [General>Existing Projects into Workspace and click
Next|:

& Import O X
Select \‘

Create new projects from an archive file or directory.

Select an import wizard:

| type filter text ‘

~ [= General ~

l 1= Existing Projects into Workspace

[ Preferences
() Projects from Folder or Archive
o CICss

@ < Back Finish Cancel

At Import — Import Projects window please select [Select archive file:] and click [Browse]. Search for
“ebv-iotc.zip” located in training material “MTB project” folder. Make sure the “ebv-iotc” project is

ticked in Projects: area. Finally, click [Finish].

E mport | x
Import Projects B
Select a directory to search for existing Eclipse projects. A
(O Select root directory: Browse...
o (@) Select archive file: IFX_loTConnect_training\MTB project\ebv_iotc.zip i Browse...
Prejedts: ‘ e
ebv_iotc (ebv_iotc/) Select All
Deselect All
Refresh
Options

Search for nested projects

Copy projects into workspace
[[] Clgse newly imported projects upon completion
[[] Hide projects that already exist in the workspace

Working sets
[ Add project to working sets New...

Select...

@ < Back Mext = Finish > eantel
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You should be seeing newly imported project in Project Explorer:

Q EBV-10TC - Hello_World_Sensors/main.c - Eclipse IDE for ModusToolb
File Edit Source Refactor Mavigate Search Project Run Wind
i B~ R @i~ 0~Q@~i® ¢ B0

5 Project Explorer 22 %% Debug 4¥ Registers % Peripherals =~ O

BES Y7 &
[bc ebv_iotc B
® Includes
= configs
= deps
& libs
= media
= oled
(= source %
= library-manager.log
L& Makefile
= makefile.init
[ QUICKSTART_DEMO.md
\ [# README.md Yy
B Hello_Worla

Ta': mtb_shared

Important: We imported a project and most importantly now is to update library set. It is of a
1 I great importance to follow steps of this sub-section.

There are multiple ways to update libraries (proceed using only one of the options):

A. Browse for “main.c” file in Project Explorer under “ebv-iotc/source” and open it (double click| or
right click|>{Open)). In Quick Panel click [Library Manager 2.1|

[ Quick Panel = Variables & Expressions ® Breakpoints ~ O

i ebv_iotc Debug (KitProg3_MiniProg4) ~
O ebv_jotc Program (JLink)
O ebv_iotc Program (KitProg3_MiniProg4)

% Generate Launches for ebv_iotc

~ Tools

rﬁ.wamwswml 20
e Library Manager 2.10 E

~ BSP Configurators (CY8BCKIT-06252-43012)

E CAPSENSEF™ Canfimiratar & 10

In the Library Manager 2.1 just click |[Update|, wait for the update to finish, wait for Update button to
get enabled and click [Clos€]. The update process might take a while. ..
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Library Manager 2.0

Application Directory: |C./EBV-IoTC/ebv_iotc

|Emerf' ter text | B
Na/l\ne Update Available Remove *
v BSPs
() CYBCKIT-062-WIFI-BT -
@ CYBCKIT-06252-43012 (ACTIVE) =
(O CYSBSYSKIT-DEV-01 ~
v ebv_iotc Libraries v
Add BSP Add Library

- ] X

Browse...

Refreshed all dependencies for project ‘basic-sample’.
0 error(s), 1 warning(s)
Successfully acquired the information.

=
Found new indirect dependencies ‘aws-1ot-device-sdk-port, wifi-mw-core, capsense, core-lib, core-make, mtb-pdl-cat1, ~
psocbemOp, recipe-make-catla, wpa3-external-supplicant, aws-iot-device-sdk-embedded-C, abstraction-rtos, clib-
support, mbedTLS Acceleration, freertos, lwip, secure-sockets, whd-bsp-integration, wifi-host-driver'.

MNote: This application uses the ModusToolbox 2.x application structure and so incompatible 3.x content is not
displayed. See KBA 236134 for instructions on modifying the application to be compatible with 3.x content. W

@

Update § Close

If you click Close before update process finishes, you will be prompted for confirmation. Click and
wait for Update button to get enabled and click [Closé].

Library Manager - Library Manager 2.0 x

o Work is in progress. Do you really want to close the window?

e (T )

B. Alternatively, in the “ebv-iotc ModusShell” terminal execute “make getlibs” command.

B Console [£! Problems =g Progress @ Memory & Terminal 2

= ebv_iotc ModusShell &2

MaliU@SILIUY2NB183U93
$ make getlibs

In the Project Explorer under “mtb_shared” you should see many newly added libraries:

ﬁ EBV-10TC - ebv_iotc/source/main.c - Eclipse IDE for ModusToolbox™

File Edit Source Refactor Mavigate Search Project Run Wind

Himiid B~ R ~Ritt~O0 -G~ ® & - B0

&5 Project Explorer 32 %% Debug ! Registers 2, Peripherals = O
5% 7Y 8

~ =5 mtb_shared A

& Archives

(= abstraction-rtos

= aws-iot-device-sdk-embedded-C

= aws-iot-device-sdk-port

= capsense

= catlemOp

= clib-support S

= cmsis

(= connectivity-utilities

= care-lib
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11.2.3 Configure WiFi credentials

Note: WiFi credentials can be changed also using serial communication terminal at later steps
__/ or at any time later.

In “ebv-iotc>configs” folder locate and open “wifi_config.h”. In lines 52 and 55 you can see
WIFI_SSID and WIFI_PASSWORD definitions, respectively. Change the values to match your WiFi
access point settings.

[%] README.md [¢ mainc  [g iotc_mtb_time.c pal ifx_i2c_config.c  [H wifi_configh &
49 * Macros
5Q REREIKARARAIKRIK KA HRAOR AR AR RO RRR KRR R ORORROR RO RO RO ORRRORROR K

51 /* SSID of the Wi-Fi Access Point to which the MQTT client connects. */

52 #define WIFI_SSID "EBV-Training"
53
54 /* Passkey of the above mentioned Wi-Fi SSID. */
55 #define WIFI_PASSWORD "AvnetGroup”
56

11.2.4 Build

Finally go back to “ebv-iotc” project in Project Explorer and execute Build Application] from Quick

Panel. In the console you should be seeing message flow with all the steps of build process. This step
takes some time...

Note: Due to number of included packages it takes some time to compile, but it only takes so
= much time for the first compile or after “Clean Application” execution. In the Console you can
follow messages flow until receiving something like:

10:01:37 Build Finished. © errors, 24 warnings. (took 5m:27s.256ms)

B Console 2 |f. Problems =g Progress [0 Memory & Terminal
CDT Build Console [ebv_iotc]

Total Internal Flash (Available) 2097152
Total Internal Flash (Utilized) 1029528
Total Internal SRAM (Available) 1046528

Total Internal SRAM (Utilized with heap) 1033496

10:01:37 Build Finished. @ errors, 24 warnings. (took 5m:27s.256ms)

11.2.5 Program and run the device application
Now you can run application using [ebv-iotc Debug (KitProg3 MiniProg4)| launch at Quick Panel.

[ Quick Panel (= Variables & Expressions ®e Breakpoints = g

~ Launches

ES ebv_iotc Debug (JLink)

¥ ebv_iote Debug (KitProg3_MiniProg4)
O ebv_jotc Program (JLink)

[¥] ebv_iotc Program (KitProg3_MiniProg4)
% Generate Launches for ebv_iotc

~ Tools

EBV-IoT — Infineon loTConnect Secure Cloud connected solution - Training Manual ver 1.4 68 of 88

{2y


https://www.avnet.com/wps/portal/ebv/

@ EBVE|ektronik Task 5: Getting hardware ready for loTConnect cloud

I An Avnet Company |

Click Run>Resume] or press F8 and check serial communication terminal...

ModusToolbox™ debugging functionality. Proceed to Section 13 Task 7: Accessing the device

- Task accomplished: Congratulations, the device has now been flashed using
V_
* through serial terminal.
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12. Task 6: Flashing device firmware

\O, Tip: For the “Full” version of the Infineon loTConnect Cloud connected solution please

= proceed to Section 13 Task 7: Accessing the device through serial terminal

Please refer to the Infineon’s ModusToolbox ™ Programmer Software pages for application download
and “ModusToolbox™ Programming GUI user guide” (link) for installing instructions or use the
installation and guide provided in the training material.

Assuming the PSoC 62 Pioneer Kit is properly connected to your PC using micro USB cable, proceed
with launching ModusToolbox™ programmer in your Windows under:

A. Recently added->mtb-programmer x.x, or
B. [Infineon technologies|>mtb-programmer x.x|

where x.x denotes version of the installed tool.

1. Select “CY8CKIT-06252-43012" from the drop-down menu. Usually, the tool recognizes connected
kit automatically.

2. Click on |;| and browse for valid “hex” type firmware file located in “Firmware” folder of provided
training material.

3. Click on|Connect].

(= | [=3
Probe/Kit: CY8CKIT-06252-43012-1E0F177E01051400 | Platfor oC 61/62/¢ O O j = j
Open 6 Power  Connet = ogram Read Verify
Settings x
Program Settings ‘
File D:/EBV-IoT-IFX_IoTConnect_training/Firmware/EBY-IoT-1FX Xensiv IoTConnect Demo v1.1.hex D
Reset Chip
Verify Regions
External Memory O
Program Security Data[_]
Probe Settings
Interface SWD
Clock (KHz) 2000 )
Reset Type Soft v
Sflash Restrictions Erase/Program Sflash prohibited w
Log
~
Info : [CyBridge] Start the API initialization
Info : [CyBridge] The hardware initialization has completed in 794 ms
Info : Connected - KitProg3 CMSIS-DAP BULK-1E@F177E01@51408@ FW Version 2.48.1241 v
PressFiforhep Mot Connected
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When “Program” icon gets enabled, click and wait for “Info : ** Programming Finished
**” message or “Device programmed successfully” message is displayed.

mtb-programmer % - O x
o~ s
ProbefKit: CYSCKIT-06252-43012-1E0F177E01051400 Platform: | PSoC 61/62/¢ @ @ @ 8 @
Open Power Disconnect Erase Program Read Verify
Settings x
Program Settings
File D:/EBV-IoT-IFX_IoTConnect_training/Firmware/EBV-ToT-IFX Xensiv IoTConnect Demo v1.1.hex E]
Reset Chip
Verify Regions
External Memory
Program Security Data
Probe Settings
Interface SWD
Clock (KHz) 2000
Reset Type Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : cyp_get_mpn ~
Info : ** Detected device PN: CY8C624ABZI-52D44 SiliconID: E453 Revision: 12 FamilyID: 182 DIE: PSoC6A2M
Info : reset run
Info : SWD DPIDR @x6ba@2477 W
o oty e crcsazssion

Now click Disconnect.

Task accomplished: Congratulations, you have now successfully flashed the device.
of —
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13. Task 7: Accessing the device through serial terminal

Please use device manager to get your device serial port number information like the one depicted
bellow:

File Action View Help
e DEBIHEI B EXGE

~ Keyboards

=» Mice and other pointing devices

& Monitors

@ Network adapters

L Other devices

v % POTG (LUM el LPT)

== KitProg3 USB-UART (COM14)
=% USB Serial Device (COMB89)

SETFINUgUEles

== Processors
W Security devices
@ Sensors v

.

Use your favorite serial communication terminal for serial communicatin monitoring. We use TeraTerm or
you can use ModusToolbox integrated serial communication terminal. Use following settings:

e Port number: as retrieved from “Device manager”
e Speed: 115200

e Data: 8 bit
e Parity: none
e Stop bhits: 1

e Flow control: none

When device is connected and after resetting you should see flow of data in your terminal, like the one
bellow:

a Terminal - COM14

File Edit Setup Control Window Help

(00:00:00.000) [optiga_trust_helpers]: OPTIGA Trust: Starting initialization...
(00:00:00.079) [optiga_trust_helpers]: optiga_util write_data: successful
(00:00:00.079) [optiga_trust_helpers]: OPTIGA Trust initialization successful.
(00:00:00.162) [optiga_trust_task]: Your certificate is:

————— BEGIN CERTIFICATE-----
MIICxTCCAkugAwIBAgIECsw3ADAKBggqhkjOPQQDAzBYMQswCQYDVQQGEWIERTEA
MB8GALUECgWYSW5maW51b24gVGVjaG5vbGOnalVzIEFHMRMWEQYDVQQLDApPUFRI

ROEOVEOPMS swKQYDVQQDDCIIbmZpbmVvbiBPUFRIROEOVE@PIFRYdXNOIEOEQOEgE
MzA2MB4AXDTIyMDcwWNDASNDgyM1oXDTQyMDcwNDASNDgyM1owDTELMAKGATUEAWWC
IiIwWTATBgcqhkjOPQIBBggqhkjOPQMBBWNCAAS2XMFg180WaEb20xsKEReOB+A
5T1X0Qoa7rOFRrhy5j2gHjcYUU2yEea+bY3vHBzQzB24E3HQzP1Py/yk5rfio4IB
MjCCASAwWYAYIKwYBBQUHAQEEVDBSMFAGCCSGAQUFBzAChkRodHRwczovL3BraS5p
bmZpbmVvbi5jb20vT3BOaWdhVHI1c3RFY2NDQTMwWNi9PcHRpZ2FUcnVzdEV]jYONB
MzA2LmNydDAdBgNVHQAEFgQUAXtoQYtIPpfXRIa7k4V9sjX/5fYwDgYDVROPAQH/

You can see message flow with various content including sensor values.

13.1.1 Setting WiFi credentials using serial terminal
In this step we will set WiFi credentials if the one provided in the source code does not match. Within
terminal tool press either “x” or “X” at any time. You should be seeing a menu with few options:
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a Terminal - COM14
File Edit Setup Control Window Help

H followed by 'ENTER' to show this menu

S{WiFi SSID} followed by 'ENTER' - SET WiFi SSID

P{WiFi Password} followed by 'ENTER' - SET WiFi Password

U followed by 'ENTER' to display UID

Q followed by 'ENTER' to display QR code web link

D followed by 'ENTER' to use default values

R followed by 'ENTER' to review credentials

W followed by 'ENTER' to write credentials to EEPROM and EXIT
L{x} followed by 'ENTER' to set printf debug level {x} 2-8
M{lat,lon} followed by 'ENTER' to set latitude/longitude

E followed by 'ENTER' to EXIT!

To change WiFi credentials, please use following commands:

e “S{WiFi SSID}” followed by ‘ENTER’
e “P{WiFi Password}” followed by ‘ENTER’
o “W” followed by 'ENTER' to write credentials to EEPROM and EXIT

a Terminal - COM14

File Edit Setup Control Window Help
SMyWiFi.

OK.

PMyPasswordd

OK.

W

Saving data...OK.

When you notice “Successfully connected to Wi-Fi network '{WiFi SSID}'” or you notice
“Publishing data” you are ready to go for next step.

the screen. Please do not mind and finish typing, and press ‘ENTER’. You should be seeing
“OK” message and valid enter.

Tip: For a WiFi access point you can use your PC and create “Mobile hotspot” located next to

@ Note: During entering credential data it may happen some messages override messages on
\ ! 4
-O- WiFi settings in your task bar.
/ \

L J

Additionally, you can set “level” of printed messages. Default level is “L6” which prints additional
messages on terminal. Following please find all the “level” settings:

e L2: Setting print log message level for Critical error, caller function crashes the application,
e L3: Setting print log message level for Error recovered,

e L4: Setting print log message level for Notice on possible error,

e L5: Setting print log message level for Information describing expected outcome,

e L6: Default - Setting print log message level for Additional information useful for debugging,
e L7: Setting print log message level for Less important information useful for debugging,

e L8: Setting print log message level for all levels.
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a Terminal — COM14

File Edit Setup Control Window Help

L5d

Setting print log message level for Information describing expected outcome
OK

L6

Setting print log message level for Additional information useful for debugging
OK

Ed

EXIT & no saving... OK.

When “level” set, type E followed by ‘Enter’.

For demonstration purposes you can also set position (latitude/longitude) of the device. When in the
menu use command “M{latitude,longitude}” followed by ‘Enter’, “R” followed by ‘Enter’ to review values
and “W” followed by ‘Enter’ to store values in the EEPROM.

a Terminal - COM14

File Edit Setup Control Window Help
M48.17189112731593, 11.801411796690346

OK

R

WiFi SSID: EBV-Training
WiFi Password: AvnetGroup
EBV LOGs level: 8

Your position:
https://www.google.com/maps/search/?api=1&query=48.17189112731593,11.801411796690346

v~ Tip: To set a position you can directly copy values from the Google Maps adding “M” prior like
O- e.g. above: “M48.17189112731593, 11.801411796690346"

V4 \
2
Task accomplished: Congratulations, the device has now been properly setup and is ready
Y=| tocheck device connecting to the loTConnect cloud.
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14. Task 8: Connecting the demo to loTConnect Cloud

Important: This task requires the device being programmed with loTConnect enabled
! application. Task 5: Getting hardware ready for loTConnect cloud has to be completed prior
— N the task.

14.1. Overview

Actually, your device should already be connected to the cloud. We will walk through the cloud platform
back-end for more detalils.

14.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

Once device fully programmed, open the serial communication terminal. The device firmware should
automatically reset, and the terminal output should show a successful connection to the loTConnect
cloud:

a Terminal - COM14

File Edit Setup Control Window Help
(00:00:14.709) [wifi_connection_task]: Successfully connected to Wi-Fi network 'Admin’
(00:00:14.711) [wifi_connection_task]: IPv4 Address Assigned: 192.168.1.16

(00:00:16.685) [sensor_task]: ----------------m-mme o
(00:00:16.685) [sensor_task]: CO02: : 438 ppm

(00:00:16.689) [sensor_task]: Pressure ¢ 1002.50 mbar

(00:00:16.695) [sensor_task]: Temperature: 28.82 *C

(00:00:16.701) [sensor_task]: -------------c---m -
Obtaining network time......

Time received from NTP. Time now: 2023-05-21T08:36:05.000Z!
(00:00:16.715) [wifi_connection_task]: Initializing IoTConnect SDK...
Discovery response parsing successful.

Sync response parsing successful.

CPID: cO80***

ENV: avnetpoc

MQTT connection successful.

From the loTConnect cloud backend, go to |[Device list

_ 1OTConnect X +

C (@ @& avnetiotconnectio f | Uiziz )]
I_‘\ V N E T AR 107 Dashboara @Y Dashboards + @ create Dashboard s ? A v

loT Dashboard K

Command Twin Subscription

Plan
EBV - loTConne

User
4 2/50

Device Counter

Certificates

Notification Events
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click your device Unique Id in the Devices menu to access its content.

I0TConnect X +

C (¢ @& avnetiotconnectio,

Home / Overview / Device / Devices

Devices Filter: None Y7 ¥ »

Unique ID Name ~ Template Entity Last Connection Last Communication Device Status Status Actions
l O zRYZTQEA.. &  BUros Xensiv D EBV-IoT EBVIFXT 11 minutes ago <1 min ® Active g O
- : -

i! Dashboards v

@R 107 Dashboard

E Templates {i} Devices Commands a Rules & Firmware 5 Batch Import K,‘ Data Export

Then click tab to see the incoming raw JSON stream from the device:

Home / Overview / Device / Devices

Simulator @

Info zRYZTQEAHAAFAAAKCRtcABUASQBOgBA [Uros Xensiv Demo] M

Latest Value
Graph Tabular w
' Live Data f

"time":"5/21/2023, 10:47:41 AM""reporting™:

h
Command - . .
{"version""01.00.00""cpu":"3.123""co2level":"1198" "pressure™"988.36" "temperature™:"25.34""LED1":"1"),"timezone™"(UTC+02:00) Europe/Ljubljana"}

Twin Property

o {"time":"5/21/2023, 10:47:35 AM""reporting":
Notifications {"version":"01.00.00""cpu":"3.123""co2level":"1207""pressure""988.39" "temperature":"25.34""LED1":"1"},"timezone":"(UTC+02:00) Europe/Ljubljana"}
Diagnostics
{"time":"5/21/2023, 10:47:30 AM""reporting":
LifeCycle {"version""01.00.00""cpu":"3.123""co2level":"1207""pressure™"988.36" "temperature":"25.37""LED1""1"),"timezone""(UTC+02:00) Europe/Ljubljana"}

Historical Data

Allocation

Next, click tab to send a command to the device. The template defined 1 “Set board LED”
command, allowing to set the status of user LEDs on the board.

Select “Set LED1” command with parameter 0 or 1 to light the LED on or off, then press the Execute
Command button.

Home / Overview / Device / Devices

Simulator (@

Info zZRYZTQEAHAAFAAAKCRtcABUASQBOgBA [Uros Xensiv Demo] m 0
Latest Value Select Command! Parameter Value:*
Twin Property

Command Executed On (UTC) Executed By Status Executed Count
Notifications

LED1 0 May 20, 2 Uros Mali Executed 1
Diagnostics

LED11 May 20, 202 Uros Mali Executed 1
LifeCycle

LED1 0 May 19, 2023 21:08:02 Uros Mali EBxecuted 1

The corresponding board LED should change its status accordingly within a second.
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Click |Historica| Data| tab to see all the data that was log for this device. The default retention policy
allows for 90 days or a maximum of 15 GB of data (whichever is encountered first). Select
|Attributes—)AII| and click . You should see chart with values starting to display.
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Home /|

/ Overview / Device / Devices

Info zRYzTQEAHAAFAAAKCRtcABUASQBOgBA [Uros Xensiv Demo]
Latest Value NOTE: The retention policy for histo r a maximum of 15 GB of data (whichever is encountered first). If you would like to increase this limit please update the
Cosmos DB Live Data Stream p gs => Configurations menu
Live Data
Export

Command
Twin Property Start Date End Date Attributes =
Notifications 2023-05-20 = 2023-05-21 = All Selected ~ a
Diagnostics All Sensors

oo —— M co2level

LifeCycle

pressure

1200 —— {3 temperature

istori LED1
Historical Data 1000

Allocation 800

Value

600

Ann

Any area of the graph can be zoomed in by simply selecting the desired portion of the graph. Then
double click the graph to zoom out and get back to the specified date interval. The date interval Start
Date and End Date can be used to render extended time interval.

Enabling or disabling specific sensor data rendering is possible by clicking the corresponding sensor
checkbox on the right side.

Task accomplished: The device is securely connected to the loTConnect cloud using TLS
certificate based mutual authentication with custom PKI. Also, the device private key is stored
inside the secure element to ensure highest security level. Device access and remote
configuration is easily managed through the loTConnect backend portal.

<«
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15. Task 9: Remote access from EBV Mobile App

15.1. Overview

EBV Elektronik has designed a Mobile Application compatible with loTConnect that allows the end user
to access his own account at the loTConnect OEM cloud space, visualize data and interact with the
device. The source code for this mobile application is provided for free as an example and can be found
in the provided training material.

From the previous tasks, device has been onboarded to the loTConnect OEM cloud account. The device
secure element is used as a unique identifier for the device in the cloud and attests the authenticity of
the device. It also allows a better control of the OEM supply chains as devices can be populated in the
OEM cloud early on during production stage. Overbuilding or cloning devices becomes impossible thus
efficiently protecting OEM’s revenue and reputation.

The loTConnect cloud topology allows to have devices assigned to entities within the OEM cloud
account. This feature is used to support an unlimited number of end-users and devices. Therefore, each
end-user will have a dedicated entity, ensuring end-user data and information privacy with a login to this
entity.

The EBV Mobile App makes the process completely transparent and greatly simplifies the workload for
both OEM and end-users.

15.2. Step by step guide

To Do: The task does not involve any software development. Instead, it is only required to
process the steps in the right order and to understand their underlying effects.

15.2.1 Install the EBV Mobile App on your smartphone
The mobile application is available for iOS and Android platforms. Open a browser on your smartphone
to one of the links below with respect to your smartphone operating system:

iIOS:
https://install.appcenter.ms/orgs/softwebsolutions/apps/ebv_iot-ios/distribution_groups/dev

Android:
https://install.appcenter.ms/orgs/softwebsolutions/apps/ebv_iot-android/distribution_groups/dev

Click to download the application and Install it on your phone.

Since the app is not yet published on the application store, user will have to trust the application
manually before running the app.
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15:51 v T . v T .

General VPN & Device Management Softweb Solutions Inc.

AirDrop Apps from developer “iPhor ibution: Softweb

VEN VPN Not Connected Solutions Inc” Phone and wi

AirPlay & Handoff not run until tf

Picture in Picture

CarPlay
ENTERPRISE APP APPS FROM DEVELOPER "IPHONE DISTRIBUTION
SOLUTIONS INC!

Softweb Solutions Inc.
iPhone Storage Mot Trusted [ verified

Background App Refresh

Date & Time
Keyboard

Fonts

Language & Region

Dictionary

VPN & Device Management

For Android: the settings can be directly accessed via a browser popup, click and then enable

Allow from this source:

1651 T@@ + o RIS 47% 16:51 @& T » o RS 47% 1651 L@ +

< Install unknown apps < Install unknown apps

Edge Edge

108.0.1462.76 108.0.1462.76

Allow from this source Allow from this source ®

Installing apps from this source may put your Installing apps from this source may put your
phone and data at risk. phone and data at risk.

G Edge

For your security, your phone is not allowed
to install unknown apps from this source.

Cancel Settings
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15.2.2 Open the app and connect to your loTConnect OEM root account
The first step is to run the mobile app to connect to the loTConnect OEM root
cloud account. This step would typically not happen on a production application
as the app would embed credentials with limited accesses to allow connection
to the OEM cloud account, to create end user account and to claim devices.
This app is provided as a demonstrator; therefore, it is designed to allow
connecting to any loTConnect OEM cloud account as long as root user
credentials are provided. The root user credentials were obtained when
registering for loTConnect access in sub-section 2.3 Create loTConnect
cloud account of this document or check for “Owner” role in your users list at
your instance of loTConnect cloud.

Root User Login

Enter Root Email Address and Root Password.

Entler your loTCannect user account credentials 1o create
2nd access your personsl devices.

! CPNNECY'
Solutioes Suite

Click Connect.

. Tip: You can continue logging in using root account where all created devices from your
- = instance of the loTConnect cloud will be displayed. Skip following step and continue at sub-
“<="  section 15.2.5 Device list and menu overview

15.2.3 End-user signs up to the OEM cloud account
Note: In a real production application, below screenshot would be the first screen seen by
__/ end-user where he would need to provide his user cloud account credentials or sign-up as a
new user.

Click
The following sign-up form will expect at least the following 4 mandatory fields to be provided:

e User first name.
e User last name.
e User email address.
e User password.
Note: At the time of writing this document, the app will not perform any email verification, but it
E/ is recommended to choose a valid email address, so credentials can be retrieved if lost.

Click [Submif|.
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SIGN UP

FIRST NAME
John

LAST NAME
Doe

EMAIL ADDRESS
john.doe@gmail.com

Login

PASSWORD EMAIL ADDRESS

john.doe@gmail.com A

EBV-loT 5 | PASSWORD
User has been successfully added. . (5]

Ac OK
- CONNECT

US (+1) v Contact Number

CONNECT

New User? Sign-Up

New User? Sign-Up

Country

State

4 SUBMIT CANCEL .
vk Enter your loTConnect user account credentials to create

and access your personal devices.

Enter your loTConnect user account credentials to create
and access your personal devices.

/IOTCONNECT" - /IOTCONNECT"
Solutions Suite p Solutions Suite

/IOTCONNECT"
Solutions Suite

After clicking the confirmation popup, user is sent back to the login screen where he can enter his
credentials.

Click [Connect]|.

15.2.4 Add a device to the end-user cloud account

In the loTConnect cloud ecosystem, devices are not created at this stage since device resource creation
happened during production stage. Instead, device ownership is simply transferred from the OEM root
entity to the end-user entity. The end-user entity is internally identified using the end-user email address
to guarantee uniqueness.

From loTConnect perspective, devices are uniquely identified using the unique ID of the secure element.
While this information could be manually entered by the end-user, it is much easier to use a QR code.

Note: The QR code has been generated in the sub-section 9.2.4 Get QR code for seamless

__/ device onboarding and should be there in the “Scripts” folder. If for whatever reason do not
have access to the QR code use alternative approach. The HTTPS line with device QR code
is printed in the terminal output after device reset or retrieve the link through terminal access
as described in 13 Task 7: Accessing the device through serial terminal. Double click the
link or use the link to render the QR code in a browser.

1 COM14 - Tera Term VT - O hed
Flle Edit Setup Control  Window Help

MNE866SGTQDullwodk jJ ixsHDgNGI A3 12 +rQ3J9Bc ET FhZSZ29RoCMAD5uzUS /L1
Muil44HmH4tMz jaZQgOnc?KZeARUBNoLCT 1UgHMum3 s 18QZFuw3B6mhd=
END CERTIFICATE:

Yo
zRYzTQERHRRFRRRHCRtBRHURSQBOQBR

Pt e
Hn&nhne lITF 8

Click QR code icon| from the on top right corner, to allow access to the camera, and scan the device
QR code.
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Enter a device friendly name, then click |Add Devicel.

ADD DEVICE ADD DEVICE

DEVICE IDENTIFIER
0123926D6BD986DD01

FRIENDLY DEVICE NAME
Thibault's C3 Device

ADD DEVICE

EBV-loT
Device added successfully

ADD DEVICE

“EBV - loTConnect” Would
Like to Access the Camera

This app requires access to
the camera

OK

o Device identifier musthave previously been
created by Company in the loTConnect cloud
backend.

e Device can only be ¢ e Device can only be oWned by one end
user account.

user account.

15.2.5 Device list and menu overview
The end-user device is now visible in the EBV Mobile App and can be accessed by clicking the device

friendly name.
Additionally, the top left button provides access to the app main menu:

DEVICES
3] EBVElektronik X

Root User Login:

{0 Thibault's C3 Device Welcome
O ankit.emea+1@gmail.com
hn D
(@ RJonnlbos User Login:
john.doe@gmail.com
) CPID:
@ Devices 3FBFD07F3C894964A76EAEED9A72C46A
Backend URL:
m Statistics avnetuser.iotconnect.io
App Version:
o 3 1.0.0 (1.0.22)
~ User Settings
78) Switch User
() Logout

Technology. Passion. EBV.
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The app main menu provides useful information and actions to the end-user:

e |Devices|. access the device list view.

J : display some metrics about the current activity on the OEM cloud.
J : provides a summary of the login information that is used to connect the EBV Mobile App to
the loTConnect OEM cloud.
J : allow switching between user accounts without losing current user account setup.
J : clear both root and user credentials. This would essentially reset the app to a similar state after a
fresh install.
Note: The menu options are quite simple and limited as this app is only intended as a
demonstrator app.

15.2.6 Interacting with the device

From the device list screen, just click on the device friendly name to access its content. The data carried
out by the device is represented by a set of widgets, such as graphs, gauges, sliders, LEDs and so on.
The widget type used to represent the data is defined in the device template file that was uploaded to the
loTConnect cloud backend in the previous tasks.

Note: The look and feel of the widgets representation may vary among various
implementations.

15:39 .
& Thibault's C3 Device

15:39
< Thibault's C3 Device

15:39
& Thibault's C3 Device

Data History Properties Command Data History  Properties Command Data History  Properties Command

ST LSM6EDSL accelerometer

sensor ST LPS22HB pressure sensor

\

1040

ST HTS221 humidity sensor

1

1000 ———0-

970 983

0 42 100

23867 M 2:38E7OM  2:30:00 P 2:30:00 PM

ExEYyE:z

ST HTS221 humidity sensor

] ST HTS221 temperature sensor
ST LSMBDSL gyroscope sensor

00 OO0~
—

ST HTS221 temperature sensor

User LED1

ST LSM303AGR magnetic
sensor User LED2

3°°T—o—o—o—o—o—ﬂr—o—‘° ‘

200

00 User LED3
o T 0 21 40

-100

LED widgets are interactive and can be clicked to toggle ON or OFF the corresponding device LED.

g

The upper tabs provide useful information about the selected device:

. : shows the dynamical view with widgets to render device data.

. : display past user data in a single graph view, where individual sensor data can be enabled or
disabled.
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o |Properties|: display properties latest status as reported by the device. In this hands-on only the firmware

version of the device is reported as “fw” property.

. : ability to remotely execute commands on the device. This feature is transparently used when
pressing the LED widget to toggle the corresponding device LED.

Task accomplished: Congratulations! Device can now be fully operated by the end-user from
Y=| the EBV Mobile App.
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Thank you!

We hope you enjoyed the training. We would like to kindly request just five minutes of your time to
participate in a survey related to the training you attended. Your feedback is incredibly valuable to us as
we strive to improve our training programs and provide the best possible experience for future
participants.

The survey consists of few short questions and is designed to gather insights on your training
experience, any suggestions you may have, and areas where we can enhance our services. Your
responses will remain confidential.

Please scan or click on the following QR code access the survey:

Thank you in advance for your time and valuable feedback. Should you have any questions or require
further assistance, please feel free to reach out to me. Your participation is genuinely appreciated.

For more information, please contact your local EBV elektronik representative or at ssc@ebv.com.
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EBV Elektronik GmbH & Co. KG | D-85586 Poing | Im Technologiepark 2-8 | Phone: +49 (0)8121 774-0 | www.ebv.com

EBV Regional Offices status juy 2022

AUSTRIA

1120 Wien

GriinbergstraBe 15/1, 4. Stock
Phone: +43189152 0

Fax: +43189152 30

BELGIUM

1831 Diegem

De Kleetlaan 3

Phone: +32 27160010
Fax: +32 27208152

BULGARIA

1505 Sofia

48 Sitnyakovo Blvd., Serdika
offices,10th floor, Unit 1006
Phone: +359 2 9264 337
Fax: +359 2 9264133

CZECH REPUBLIC

18600 Prague

Amazon Court, Karolinska 661/4
Phone: +420 2 3409101

Fax: +420 2 34091 010

DENMARK
Elkjeervej19,1sal
DK-8230 Abyhgj
Phone: +45 8 6250 466
Fax: +45 8 6250 660

ESTONIA

80042 Parnu

Suur-Joe 63

Phone: +372 5 8864 446

FINLAND

02240 Espoo
Klovinpellontie 1-3, 6 floor
Phone: +358 9 2705279 O
Fax: +358 9 27095498

FRANCE

91300 Massy Cedex (Paris)
Le Copernic bat B

12 rue Jean Bart

Phone: +331644729 29

35700 Rennes

16, Rue de Jouanet
Phone: +33 2998300 51
Fax: +33 2998300 60

67400 lllikirch Graffenstaden
35 Rue Gruninger

Phone: +33 3 904005 92
Fax: +33 388651125

31500 Toulouse

8 chemin de la terrasse
Parc de la plaine
Phone: +33 5 610084 61
Fax: +33 5 610084 74

69693 Venissieux (Lyon)
Parc Club du Moulin a Vent
33, Av. du Dr. Georges Lévy
Phone: +33 472780278
Fax: +33 4780080 81

GERMANY

85609 Aschheim-Dornach
Einsteinring 1

Phone: +49 89 388 882 0
Fax: +49 89 388 882 020

10553 Berlin
Kaiserin-Augusta-Allee 14
Phone: +49 30 747005 O
Fax: +49 30 747005 55

31275 Lehrte

GauBstr. 10

Phone: +49 5139 8087 O
Fax: +49 5139 8087 70

59439 Holzwickede
WilhelmstraBe 1

Phone: +49 230194390 O
Fax: +49 230194390 30

41564 Kaarst

An der Gumpgesbrlicke 7
Phone: +49 21319677 0
Fax: +49 21319677 30

71229 Leonberg

Neue RamtelstraBe 4
Phone: +49 7152 3009 0
Fax: +49 7152 759 58

90471 NUrnberg
Lina-Ammon-StraBe 19B
Phone: +49 911 817669 0
Fax: +49 911 817669 20

04435 Schkeuditz
Frankfurter StraBe 2
Phone: +49 34204 4511 0
Fax: +49 34204 4511 99

78048 Vs-Villingen
Marie-Curie-StraBe 14
Phone: +49 772199857 0
Fax: +49 772199857 70

65205 Wiesbaden
BorsigstraBe 36

Phone: +49 6122 8088 O
Fax: +49 6122 8088 99

HUNGARY

M7 Budapest

Budafoki t 91-93, West Irodahaz
Phone: +36143672 29

Fax: +36143672 20

ISRAEL

4581500 Bnei Dror
Tirosh1

Phone: +972 977802 60
Fax: +972 37601115

ITALY

20095 Cusano Milanino (MI)
Via Alessandro Manzoni, 44
Phone: +39 02 660962 90
Fax: +39 02 660170 20

50019 Sesto Fiorentino (FI)
Via Lucchese, 84/B
Phone: +39 05 543693 07
Fax: +39 05 542652 40

41126 Modena (MO)

Via Scaglia Est, 31

Phone: +39 059 292 4211
Fax: +39 059 292 9486

00155 Roma (RM)

Via de Settebagni, 390
Phone: +39 06 4063 665/789
Fax: +39 06 4063 777

35030 Sarmeola di Rubano (PD)
Piazza Adelaide Lonigo, 8/11
Phone: +39 049 89747 01

Fax: +39 049 89747 26

10144 Torino (TO)

Via Treviso, 16

Phone: +39 01126256 90
Fax: +39 011 26256 91

IRELAND

Fitzwilliam Hall
Fitzwilliam Place

Dublin 2

D02 1292

Phone: +35314097 802
Fax: +353 14568 544

NETHERLANDS
Zonnebaan 9

3542 EA Utrecht
Phone: +31346 5830 10
Fax: +31346 5830 25

NORWAY

181 Oslo
Brannfjellveien 11
Phone: +4722 6717 80
Fax: +47 22 6717 89

POLAND

80-838 Gdansk

Targ Rybny 11/12

Phone: +48 58 30781 00

P02-676 Warszawa
Postepu 14
Phone: +48 22209 88 05

50-062 Wroclaw

Pl. Solny 16

Phone: +48 7134229 44
Fax: +48 7134229 10

PORTUGAL

4400-676 Vila Nova de Gaia Unipessoal
LDA / Edificio Tower Plaza

Rotunda Eng. Edgar Cardoso, 23 - 14°G
Phone: +35122 092026 0

Fax: +35122 0920261

ROMANIA

020334 Bucharest

4C Gara Herastrau Street

Building B, 2nd Floor - 2nd District
Phone: +40 215281612

Fax: +40 2152816 01

RUSSIA

620028 Ekaterinburg
Tatischeva Street 49A
Phone: +7 343 31140 4
Fax: +7 343 31140 46

127486 Moscow
Korovinskoye Shosse 10,
Build 2, Off. 28

Phone: +7 495730317 0
Fax: +7 4957303171

197374 St. Petersburg

Atlantic City, Savushkina str 126,
lit B, premises59-H, office 17-2
Phone: +7 812 635706 3

Fax: +7 812 635706 4

SERBIA

1070 Novi Beograd
Milentija Popovica 5B
Phone: +3811140499 01
Fax: +3811140499 00

SLOVAKIA

82109 Bratislava

Turcianska 2 Green Point Offices
Phone: +4212 321141

Fax: +42123211M4 0

SLOVENIA

1000 Ljubljana

Dunajska cesta 167

Phone: +38615609 778

Fax: +386 15609 877

SOUTH AFRICA

7700 Rondebosch, Cape Town
Belmont Office Park, Belmont Road
1st Floor, Unit 0030

Phone: +27 21402194 0

Fax: +27 21 4196256

3629 Westville

Forest Square,1 Derby Place
Suite 4, Bauhinia Building
Phone: +27 3127926 00

Fax: +27 3127926 24

2128 Rivonia, Sandton
Johannesburg

33 Riley Road

Pinewood Office Park
Building 13, Ground Floor
Phone: +271123619 00
Fax: +27112361913

SPAIN

08014 Barcelona

c/Tarragona 149 - 157 Planta 19 1°
Phone: +34 93 47332 00

Fax: +34 93 47363 89

39005 Santander (Cantabria)
Racing n° 5 bajo

Phone: +34 94 22367 55
Phone: +34 94 23745 81

28760 Tres Cantos (Madrid)
c/Ronda de Poniente 14 - 22 planta
Phone: +34 9180432 56

Fax: +34 918044103

SWEDEN

16440 Kista

Isafjordsgatan 32B, Floor 6
Phone: +46 859 47023 0O
Fax: +46 859 470231

SWITZERLAND

8953 Dietikon
Bernstrasse 394
Phone: +4144 74561 61
Fax: +41 44 74561 00

TURKEY

06520 Ankara

Armada Is Merkezi
Eskisehir Yolu No: 6, Kat: 14
Ofis No: 1406, Sogutozu
Phone: +90 312 2956 361
Fax: +90 216 5288311

34774 Umraniye / Istanbul
Tatlisu Mahallesi Pakdil Sokak 7
Phone: +90 216 5288310

Fax: +90 216 5288311

35580 Izmir

Folkart Towers

Manas Blv. No 39 B Blok
Kat: 31 Ofis: 3121

Phone: +90 232 390 9196
Fax: +90 216 5288311

UKRAINE

03040 Kiev

Vasilovskaya str. 14

off. 422-423

Phone: +380 44 496222 6
Fax: +380 44 4962227

UNITED KINGDOM
Maidenhead (South)
Berkshire, SL6 7RJ

2, The Switchback
Gardner Road

Phone: +4416 28778556
Fax: +4416 28783811

Manchester (North)

M22 5WB

Manchester International Office Centre
Suite 3E (MIOC) Styal Road

Phone: +4416149934 34

Fax: +4416149934 74

Technology. Passion. EBV
ebv.com

€ EBVEIektronik

I An Avnet Company |


https://www.avnet.com/wps/portal/ebv/
http://www.ebv.com/
https://www.avnet.com/wps/portal/ebv/company/locations-contacts/

